BMC Workbench *for DB2* User Guide

Supporting

Version 1.1.00 of BMC Workbench *for DB2*
Version 11.2.00 of BMC High Speed Utilities *for DB2*
Version 11.2.00 of BMC Object Administration *for DB2*
Version 11.2.00 of BMC Performance *for DB2 Databases*
Version 11.2.00 of BMC Performance *for DB2 SQL*
Version 11.2.00 of BMC Recovery *for DB2*

April 2016
Contacting BMC Software

Several methods are available for contacting BMC Software.

You can access the BMC Software website at http://www.bmc.com. From this website, you can obtain information about the company, its products, corporate offices, special events, and career opportunities.

United States and Canada

Address
BMC SOFTWARE INC
2103 CITYWEST BLVD
HOUSTON TX 77042-2827 USA

Telephone
1 713 918 8800
or
1 800 841 2031

Fax
1 713 918 8000

Outside United States and Canada

Telephone
+01 713 918 8800
Fax
+01 713 918 8000

© Copyright 2013-2016 BMC Software, Inc.

BMC, BMC Software, and the BMC Software logo are the exclusive properties of BMC Software, Inc., are registered with the U.S. Patent and Trademark Office, and may be registered or pending registration in other countries. All other BMC trademarks, service marks, and logos may be registered or pending registration in the U.S. or in other countries. All other trademarks or registered trademarks are the property of their respective owners.

Explorer is a trademark or registered trademark of Cisco Systems, Inc. and/or its affiliates in the United States and certain other countries.

DB2, IBM, IBM z, RACF, and z/OS are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both.

The information included in this documentation is the proprietary and confidential information of BMC Software, Inc., its affiliates, or licensors. Your use of this information is subject to the terms and conditions of the applicable End User License agreement for the product and to the proprietary and restricted rights notices included in the product documentation.

Restricted rights legend

U.S. Government Restricted Rights to Computer Software. UNPUBLISHED—RIGHTS RESERVED UNDER THE COPYRIGHT LAWS OF THE UNITED STATES. Use, duplication, or disclosure of any data and computer software by the U.S. Government is subject to restrictions, as applicable, set forth in FAR Section 52.227-14, DFARS 252.227-7013, DFARS 252.227-7014, DFARS 252.227-7015, and DFARS 252.227-7025, as amended from time to time. Contractor/Manufacturer is BMC SOFTWARE INC, 2101 CITYWEST BLVD, HOUSTON TX 77042-2827, USA. Any contract notices should be sent to this address.
Customer support

Support website
You can obtain technical support from BMC 24 hours a day, 7 days a week at [http://www.bmc.com/support](http://www.bmc.com/support). From this website, you can:

- Read overviews about support services and programs that BMC offers
- Find the most current information about BMC products
- Search a database for problems similar to yours and possible solutions
- Order or download product documentation
- Download products and maintenance
- Report a problem or ask a question
- Subscribe to receive proactive e-mail alerts
- Find worldwide BMC support center locations and contact information, including e-mail addresses, fax numbers, and telephone numbers

Support by telephone or e-mail
In the United States and Canada, if you need technical support and do not have access to the web, call 1 800 537 1813 or send an e-mail message to [customer_support@bmc.com](mailto:customer_support@bmc.com). (In the subject line, enter SupID:yourSupportContractID, such as SupID:12345). Outside the United States and Canada, contact your local support center for assistance.

Before contacting BMC
Have the following information available so that Customer Support can begin working on your issue immediately:

- Product information
  - Product name
  - Product version (release number)
  - License number and password (trial or permanent)
- Operating system and environment information
  - Machine type
  - Operating system type, version, and service pack or other maintenance level such as PUT or PTF
  - System hardware configuration
  - Serial numbers
  - Related software (database, application, and communication) including type, version, and service pack or maintenance level
- Sequence of events leading to the problem
- Commands and options that you used
- Messages received (and the time and date that you received them)
  - Product error messages
  - Messages from the operating system
  - Messages from related software
License key and password information

If you have questions about your license key or password, contact Customer Support through one of the following methods:

- Send an e-mail message to customer_support@bmc.com. (In the Subject line, enter SupID:yourSupportContractID, such as SupID:12345.)
- In the United States and Canada, call 1 800 537 1813. Outside the United States and Canada, contact your local support center for assistance.
## Contents

**About this book**  
9

**Related publications** ................................................................. 9

**Conventions** ................................................................................. 10

**Summary of changes** .............................................................. 10

**Chapter 1**  
Overview of BMC Workbench for DB2  
15

Overview of workspaces and perspectives ........................................... 16

Overview of the BMC Workbench console ........................................ 17

**Chapter 2**  
Getting started  
19

**Prerequisites** ............................................................................... 19

Licensing .................................................................................. 19

Supported browsers ..................................................................... 20

DB2 Privileges .......................................................................... 20

Component configuration ........................................................... 20

BMC product installation requirements ........................................ 20

Logging on to BMC Workbench for DB2 ....................................... 21

Managing user access ................................................................. 22

Connecting to DB2 subsystems .................................................... 25

Selecting a subsystem for the BMC Workbench repository .......... 27

Managing a workspace layout .................................................... 28

Viewing messages and UIM properties ....................................... 29

Preparing for maintenance .......................................................... 30

Setting BMC Workbench options ................................................. 31

**Chapter 3**  
Managing workspaces  
33

Creating a workspace ................................................................. 33

Creating an entirely new workspace ............................................. 34

Creating a workspace from a template ........................................ 35

Saving a workspace .................................................................. 37

Opening a workspace ............................................................... 38

Closing a workspace ............................................................... 39

Removing a workspace ........................................................... 39

Editing workspace properties .................................................... 40

Working with templates ............................................................ 40

Managing folders .................................................................... 41
Creating a template ................................................................. 42
Removing a template ............................................................... 43
Moving and editing templates ................................................... 44

Chapter 4          Discovering DB2 subsystems and browsing catalogs  47
Discovering DB2 subsystems .................................................... 47
Creating a new DB2 object view .............................................. 47
Navigating through the DB2 catalog ....................................... 51
Creating a DB2 statement cache view ..................................... 52
Removing a view .................................................................... 53
Copying and pasting a view ................................................... 54
Browsing the catalog ............................................................ 55
Navigating to an object ........................................................ 55
Viewing related objects ....................................................... 56
Viewing object properties .................................................... 57
Exporting data ................................................................. 57
Copying data ....................................................................... 58
Setting DB2 Navigator options ............................................ 59

Chapter 5          Working with commands  61
Supported commands .......................................................... 61
Generating a command ....................................................... 62
Generating and running Alter DDL statements ....................... 63
Editing text files in Scratchpad ............................................. 64
Creating commands ........................................................... 67
Running a command from Scratchpad ................................. 67
Setting Scratchpad options ................................................. 69

Chapter 6          Tuning SQL  71
Tuning SQL workflow ........................................................ 71
Explaining SQL statements ............................................... 72
Using What-If scenarios .................................................... 73
Creating a What-If scenario ................................................ 73
Creating and editing a What-If index scenario ....................... 75
Comparing statements ....................................................... 82
Selecting a statement for SQL Analysis ............................... 84
Selecting a statement from the DB2 statement cache ............. 84
Selecting a statement from a DB2 package ......................... 85
Selecting an ad hoc statement ......................................... 86
Performance perspective ................................................ 87
SQL tab ........................................................................... 90
Indexes tab ..................................................................................................................91
Explain tab ..................................................................................................................92
Cost tab ........................................................................................................................94
Predicates tab ..............................................................................................................94
Compare tab ............................................................................................................... 95
Related Objects tab .................................................................................................. 95
Output tab ...................................................................................................................97
Setting SQL tuning options ......................................................................................98

Chapter 7 Migrating statistics ..................................................................................101
Migrating access-path statistics from the DB2 Navigator .................................. 101
Migrating access-path statistics from a SQL Tuning session ......................... 104
Setting statistic migration options ....................................................................... 107

Chapter 8 Displaying BMC utilities ........................................................................109
Creating a Utility Status view ................................................................................. 109

Chapter 9 Comparing DB2 schemas .................................................................... 113
Comparing two schemas .........................................................................................113
Schema-comparison reports ....................................................................................117
  Overview by Statement Type report .................................................................118
  Overview by Object Type report ................................................................. 121
  Details report ....................................................................................................123
Setting Schema Management options ..................................................................124
  OVERRIDE keywords ......................................................................................125

Chapter 10 Managing Backup and Recovery ...................................................... 131
Viewing recovery progress .....................................................................................131
Verifying recoverability ..........................................................................................133
  Refreshing the recoverability information .....................................................136
Estimating backup or recovery time .....................................................................136
  Estimating backup time ..................................................................................137
  Estimating recovery time ...............................................................................140
Setting Recovery Management options .............................................................143

Chapter 11 Managing JES jobs ................................................................................145
Viewing JES jobs .....................................................................................................145

Chapter 12 Managing data sets .............................................................................147
Viewing and editing a data set ..............................................................................147
About this book

This book contains detailed product information and is intended for application developers and database administrators (DBAs).

Like most BMC documentation, this book is available in printed and online formats. To request printed books or to view online books and notices (such as release notes and technical bulletins), see the support website at http://www.bmc.com/support.

**Note**

Online books are formatted as PDF or HTML files. To view, print, or copy PDF books, use the free Adobe Reader from Adobe Systems. If your product installation does not install the reader, you can obtain the reader at http://www.adobe.com.

The software also offers online Help. To access Help, press **F1** within any product or click the Help button in graphical user interfaces (GUIs).

Related publications

From the BMC Support Central website, you can use the following methods to access related publications that support your product or solution:


- View Quick Course videos (short overviews of selected product concepts, tasks, or features), which are available from the following locations:
  - Documentation Center (primary center and secured center)
  - Support Central (at http://www.bmc.com/support/mainframe-demonstrations)
  - BMC Mainframe YouTube channel (https://www.youtube.com/user/BMCSoftwareMainframe)

You can order hardcopy documentation from your BMC sales representative or from the support site. You can also subscribe to proactive alerts to receive e-mail messages when notices are issued.

**Tip**

You can access the BMC Support Central site at http://www.bmc.com/support.

---

**Conventions**

This document uses the following special conventions:

- All syntax, operating system terms, and literal examples are presented in this typeface.

- Variable text in path names, system messages, or syntax is displayed in italic text: `testsys/instance/fileName`

- Menu sequences use a symbol to convey the sequence. For example, **Actions => Create Test** instructs you to choose the **Create Test** command from the **Actions** menu.

---

**Summary of changes**

This topic summarizes product changes and enhancements.

**Version 1.1.00 May 2016**

This release adds the following new features:

- BMC Workbench now lets you edit and generate Alter DDL for the following objects:
  - Databases
  - Table spaces
  - Tables
  - Indexes
For more information, view the Quick Course "Workbench - Altering objects."

- You can now list and view the status of BMC utility jobs that are running on an IBM DB2 subsystem. For any BMC utility job, you can view the utility status detail table that displays the objects that the utility accesses.

- You can now access a tablet-optimized version of BMC Workbench. This version lets you view a Recoverability report for an object set.

- BMC Workbench now lets you submit JCL to refresh the Recoverability report.

**Version 1.1.00 November 2015**

This release adds the following new features:

- BMC Workbench now lets you compare schemas. You can receive a count and list of objects to be created, altered, or dropped and their corresponding DDL statements. You can make the following comparisons:
  - Catalog to catalog
  - DDL to DDL
  - Catalog to DDL
  - DDL to catalog

For more information, view the Quick Course "Workbench for DB2 - Comparing DB2 Schemas."

- BMC Workbench lets you customize the layout of perspectives. You can reorganize the order of the perspectives, or display only specific perspectives. You can also save, edit, and reuse the layouts.

For more information, view the Quick Course "Workbench for DB2 - Managing Layouts."

- You can now generate recovery progress reports and verify recoverability for an object set.
  - You can also estimate backup and recovery time for an object set.

For more information, view the Quick Course "Workbench for DB2 - Assessing Backup and Recovery Reports."
Version 1.1.00 May 2015

This release adds the following new features:

- BMC Workbench now lets you view lists of the following IBM DB2 Analytics Accelerator for z/OS objects:
  - Accelerators associated with a DB2 subsystem or DB2 data sharing group
  - Tables defined to an accelerator
  - Packages that have been bound with an accelerator option

- When you define a What-If index scenario during the SQL tuning process, you can now add an index based on an expression.

- BMC Workbench lets you migrate the access-path statistics for a set of objects from one subsystem to another, or from one schema to another within the same subsystem.

For more information, view the Quick Course "Workbench for DB2 - Migrating Statistics."

Version 1.0.00 June 2013

Following the original release in June 2013, some significant features were made available via PTFs accompanying small program enhancements (SPE).

This version of BMC Workbench includes the following features:

- Lets you browse the DB2 catalog

- Lets you tune a SQL statement by:
  - Viewing a dynamic graphical representation of an Explain plan
  - Creating alternative What-If options by changing the SQL statement
  - Comparing side-by-side alternative graphical Explain plans, with different What-If options
  - Evaluating the potential performance of a SQL statement by creating an index, dropping an index, or updating index statistics. This feature is available if you have a license for BMC Performance for DB2 SQL.

- Lets you execute DB2 commands

- Supports the following DML statements:
  - SELECT
— INSERT
— UPDATE
— DELETE

- Lets you browse the IBM z/OS file system in a hierarchical format
- Lets you view jobs and job output
- Lets you use the Connection Manager to define a local or a remote DB2 connection via a single UIM server
- Lets you use the Template Manager to organize templates hierarchically in user-defined folders, making it easier to find the templates that you need
- Lets you use System Authorization Facility (SAF) resources to manage individual user-access to BMC Workbench functions. For more information, see “Managing user access” on page 22.
Overview of BMC Workbench for DB2

The BMC Workbench for DB2 product offers a web-based graphical user interface (GUI) to IBM DB2 application developers and DBAs. With BMC Workbench, you can use a web browser (Microsoft Internet Explorer, Google Chrome, or Mozilla Firefox) to perform common tasks on your IBM z/OS mainframe.

BMC Workbench includes the following features:

- Browsing the DB2 catalog and data sets
  You can browse a DB2 object or set of objects, or any DB2 statement in the DB2 statement cache or in a package. You can also browse data set members and use the Scratchpad text editor to edit them.

- Tuning SQL statements
  For a selected statement, you can create alternative What-If options, use graphical Explain plans to compare the alternatives, and then tune your statement accordingly. In the graphical Explain plan, nodes represent each step in the statement; clicking a node displays details for that step from the Explain plan tables.

- Viewing jobs and job output
  You can browse Job Entry Subsystem (JES) jobs running on the LPAR where the UIM server is active.

- Executing DB2 commands
  You can navigate to a DB2 object and display and edit the syntax of a command for any of the supported DB2 commands. For more information, see “Supported commands” on page 61.

- Migrating object statistics
  You can migrate the access path statistics for a set of objects from one subsystem to another, or from one schema to another within the same subsystem.
- Comparing DB2 schemas
  You can compare two sets of data structures and generate reports showing the extent of the required changes. You can also generate Change Definition Language (CDL) that you can save and execute with the ALTER or CHANGE MANAGER product to make the schema structures identical.

- Managing backup and recovery
  You can generate reports to determine whether your object sets are recoverable. You can also view the progress of an ongoing recovery, and create What-If scenarios to estimate how long it would take to back up or recover.

- Edit and generate ALTER DDL
  You can edit and generate ALTER DDL for databases, table spaces, tables, and indexes.

Overview of workspaces and perspectives

All work in BMC Workbench is performed within *workspaces*. You can define as many workspaces as you need, and no other users can view or edit your workspaces. You can create a workspace template, which others can use to create workspaces with the same set of views. No matter where you create a workspace, it is available in the standard BMC Workbench interface or the tablet interface.

Each workspace has several *perspectives*. A perspective contains command options to perform a set of tasks, such as tuning SQL statements or running DB2 commands. The perspective displays results relating to different objects or statements in user-defined *views*. For example, you might define a view to display a subset of DB2 objects in the DB2 Navigator perspective. Performing certain actions on an object can automatically switch the perspective and open the corresponding view to display the relevant content.

For more information, view the Quick Course "Workbench for DB2 - Understanding Perspectives."

During a session, you can save a workspace at any time and return to it later in that session or another session. Workspace filters preserve your working environment. Consequently, you can partially complete a task (such as tuning SQL), save your workspace, and address another task that requires immediate attention; when time permits, you can return to your saved tuning session and continue creating What-If scenarios.
Overview of the BMC Workbench console

The BMC Workbench for DB2 main console is displayed after you log on to BMC Workbench. The product’s web-based console has one pane for managing workspaces and another for working with your DB2 objects and data sets.

When you first launch the product, the console features a welcome screen. Creating your first workspace enables all of the tools in the Workspace Manager toolbar and switches the focus in the right pane to the DB2 Navigator perspective.

Note

The following figure shows all perspective tabs and displays the DB2 Navigator perspective. If you create a workspace from a template, your screen might show only certain perspectives or might list them in a different order, based on the template's settings. For more information, see “Setting BMC Workbench options” on page 31.

Figure 1: Sample BMC Workbench console

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Workspace Manager pane</td>
<td>Lists all of your workspaces</td>
</tr>
<tr>
<td>2</td>
<td>Workspace Manager toolbar</td>
<td>Lets you create, open, and save workspaces</td>
</tr>
<tr>
<td>#</td>
<td>Description</td>
<td>Details</td>
</tr>
<tr>
<td>-----</td>
<td>--------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>3</td>
<td>Active workspace name</td>
<td>Indicates which workspace is active. An asterisk (*) indicates that the workspace has unsaved changes.</td>
</tr>
<tr>
<td>4</td>
<td>DB2 navigation pane</td>
<td>Lists all of the views that are in the currently open perspective.</td>
</tr>
<tr>
<td>5</td>
<td>Perspective tabs</td>
<td>Provides access to the specified perspective. The current open perspective is indicated in blue.</td>
</tr>
<tr>
<td>6</td>
<td>Navigate To toolbar (DB2 Navigator perspective only)</td>
<td>Lets you navigate to object types that are dependents of the selected object in the results list.</td>
</tr>
<tr>
<td>7</td>
<td>Commands toolbar (DB2 Navigator perspective only)</td>
<td>Lets you execute commands on the selected object, display properties, and display explainable statements.</td>
</tr>
<tr>
<td>8</td>
<td>View toolbar</td>
<td>Lets you perform actions on an object selected in the results pane. The available options vary according to the type of object selected.</td>
</tr>
<tr>
<td>9</td>
<td>Tasks toolbar</td>
<td>Via the Migrate Statistics button, lets you migrate access path statistics for objects selected in the results pane.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Via the Compare Schema button, lets you compare schemas for two selected objects.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Via the ALTER button, lets you edit the properties of the selected object and run the generated ALTER DDL to make your changes.</td>
</tr>
<tr>
<td>10</td>
<td>What's New</td>
<td>Lets you view details and short videos describing the new features added to BMC Workbench.</td>
</tr>
<tr>
<td>11</td>
<td>Tools</td>
<td>Lets you access system messages, set global options, and view details of the User Interface Middleware (UIM).</td>
</tr>
<tr>
<td>12</td>
<td>Logout</td>
<td>Lets you log out from the BMC Workbench console.</td>
</tr>
<tr>
<td>13</td>
<td>Options button</td>
<td>Lets you set options for the currently displayed perspective.</td>
</tr>
<tr>
<td>14</td>
<td>Close Workspace button</td>
<td>Closes the active workspace.</td>
</tr>
<tr>
<td>15</td>
<td>Layout button</td>
<td>Lets you manage the layout for your workspace.</td>
</tr>
<tr>
<td>16</td>
<td>Help button</td>
<td>Displays the online Help.</td>
</tr>
<tr>
<td>17</td>
<td>Results pane</td>
<td>Displays the results that a perspective generates, based on the type of action performed.</td>
</tr>
<tr>
<td>18</td>
<td>Results list (DB2 Navigator perspective only)</td>
<td>Displays all objects that correspond to the filter definition (for example, all objects returned by a filter in DB2 Navigator).</td>
</tr>
</tbody>
</table>
Getting started

You install the BMC Workbench for DB2 product from the Installation System. Following the installation, you must perform these tasks in order to use the product:

1 “Logging on to BMC Workbench for DB2” on page 21
2 “Managing user access” on page 22
3 “Selecting a subsystem for the BMC Workbench repository” on page 27
4 “Setting BMC Workbench options” on page 31
5 “Creating an entirely new workspace” on page 34

Prerequisites

This topic specifies the licensing, browsers, DB2 privileges, and so on that BMC Workbench requires.

---

**Note**

Information provided in this section supplements the information in the *BMC Products and Solutions for DB2 Customization Guide*.

---

Licensing

To run BMC Workbench, you must have a license for one of the following solutions:

- BMC Object Administration *for DB2*
  
  This license enables the following premium features:
  
  — Schema-comparison
  
  — Hierarchical Data Definition Language (HDDL)
  
  — Drop Recovery
- **BMC Performance for DB2SQL**
  This license enables the What-If index premium feature.

- **BMC Recovery for DB2**
  This license enables the Recovery Management premium feature.

- **BMC Performance for DB2 Databases**
  This license enables the ALTER DDL premium feature.

You can install BMC Workbench with one of these solutions or install it separately, at a later time.

### Supported browsers

BMC Workbench supports the following browsers on Microsoft Windows 7. BMC has tested BMC Workbench on the specific version numbers cited:

- Microsoft Internet Explorer 8, 9, 10, or 11
- Mozilla Firefox 39 or later
- Google Chrome 23, 24, or later

Also, you must have Adobe Flash Player version 11.2.0 or later installed.

### DB2 Privileges

You must have READ/WRITE privileges to the BMC Workbench repository tables. The default CREATOR for these tables is BMCGUD.

### Component configuration

The following configuration requirements apply to the components that work with BMC Workbench.

**User Interface Middleware (UIM)**

- You must have READ/WRITE privileges for the UIM HFS data set.

- The following requirements apply if you have multiple BMC Workbench installations sharing a single repository:
— You can have only one UIM HFS data set per repository. If multiple UIMs share a repository, they must also share the UIM HFS data set.

— All BMC Workbench installations must have the same maintenance level (same PTFs).

**DB2 Component Services (DBC)**

BMC Workbench uses GUD agents that require the DB2 DSNLOAD library. Unless that library is already included in your LINKLIST, you must add the DB2 DSNLOAD library to the <LOADLIB> tags in the GUDINIT step of the $U20INIT job.

For more information, see Knowledge Base article KA412340. See KA412340. You can access the Knowledge Base directly at [http://www.bmc.com/support/knowledge-base](http://www.bmc.com/support/knowledge-base) or from the BMC Support Central website ([http://www.bmc.com/support](http://www.bmc.com/support)).

**BMC product installation requirements**

BMC Workbench version 1.1 requires that you have version 11.2 of the CATALOG MANAGER for DB2 product installed.

**Logging on to BMC Workbench for DB2**

Use the following procedure to log on to BMC Workbench for DB2 from your web browser.

**Before you begin**

Verify that the following requirements are met:

- The required User Interface Middleware (UIM) server is running.

- You have a user ID and password with:
  - Authorization to access the host where the UIM server is installed
  - Suitable DB2 authorization for your requirements

- You know the host name of the UIM server that is connected to your DB2 server, and the port number on which the UIM server is listening.

- The DBC started task is running and the DB2 Product Configuration (LGC) agent is active.
If you are using a security package like IBM Resource Access Control Facility (RACF), or CA Technologies CA-ACF2 or CA-Top Secret, ensure that you know the ID and account details.

**To log on**

1. In a web browser, enter the URL `http://host:port/workbench/index.html`. Replace the variables `host` and `port` with the host name and port number of the UIM server.

   **Tip**

   To simplify future access, save the URL as a favorite.

2. In the Logon dialog box, enter your TSO user ID and password.

3. *(optional)* If using a security package like RACF, CA-ACF2, or CA-Top Secret, enter your group ID and account number.

4. Click **OK**.

   The Welcome screen is displayed.

   **Note**

   If you are inactive for 30 minutes, the BMC Workbench console times out and you must reenter your password.

**Where to go from here**

If this is the first time that you logged on to BMC Workbench, you must create a workspace to proceed.

**Related Information**

- “Creating an entirely new workspace” on page 34

---

**Managing user access**

By default, licensed users have full access to all BMC Workbench functions. Using the following procedures and the System Authorization Facility (SAF), you can
disable perspectives for one or more users, or assign superuser authorization to a user.

**Note**

You cannot disable access to the Workspace Manager or to the DB2 Navigator perspective.

*For ACF2 users* in these procedures, define the resource as TYPE(XFC) when the documentation refers to the RACF XFACILIT class.

---

**Before you begin**

You must have SAF authorization that enables you to create and assign the required resources.

**To create and assign authorizations**

1. For each UIM installation, create any of the following SAF resources that you need as an XFACILIT class:

<table>
<thead>
<tr>
<th>For this perspective</th>
<th>Create this SAF resource</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Locator</td>
<td>BMCGUD.WBAC.system.port.FILE_LOCATOR</td>
</tr>
<tr>
<td>Job Browser</td>
<td>BMCGUD.WBAC.system.port.JOB_BROWSER</td>
</tr>
<tr>
<td>SQL Tuning</td>
<td>BMCGUD.WBAC.system.port.SQL_TUNING</td>
</tr>
<tr>
<td>Scratchpad</td>
<td>BMCGUD.WBAC.system.port.SCRATCHPAD</td>
</tr>
<tr>
<td>Schema Management</td>
<td>BMCGUD.WBAC.system.port.SCHEMA_MANAGEMENT</td>
</tr>
<tr>
<td>Recovery Management</td>
<td>BMCGUD.WBAC.system.port.RECOVERY_MANAGEMENT</td>
</tr>
</tbody>
</table>

**Note**

Replace the variables *system* and *port* with the system name and the port number of the UIM server.
To assign superuser authorization

With superuser authorization, a user can edit and delete connections or templates owned by any user, and create or delete public connections. The user who sets up the BMC Workbench repository requires superuser authorization.

Superuser authorization is specific to each UIM. If your site stores public connections and templates on several sysplexes according to business function, you can provide superuser authorization to specific users based on their areas of responsibility.

Note
If you previously used (ACT.WBSU.host.port) to define a superuser, you do not need to change it.

1. For each UIM installation, create the following SAF resource as an XFACILIT class:

   BMCGUD.WBSU.system.port

   Note
   Replace the variables system and port with the system name and port number on the UIM server.

2. Assign ALTER authority to the superuser resource for the user requiring superuser authorization on the specified UIM.

Related Information
- “Tuning SQL” on page 71
- “Viewing and editing a data set” on page 147
- “Managing Backup and Recovery” on page 131
- “Comparing DB2 schemas” on page 113
- “Working with commands” on page 61
- “Viewing JES jobs” on page 145
Connecting to DB2 subsystems

During initialization, BMC Workbench discovers all DB2 subsystems on the sysplex where a UIM server is installed. The DB2 connections menu lists the discovered subsystems. You can also add connections to remote DB2 subsystems.

For more information, view the Quick Course "Workbench for DB2 - Using the Connection Manager."

When you initially open the Connection Manager, a table of discovered connections is displayed. An icon indicates the type of connection (Table 1 on page 25). Unless you are a superuser, you can see only your own public connections and the discovered connections. You can use the following procedure to add connections.

Table 1: Connection type icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🗞️</td>
<td>DB2 connections that you own</td>
</tr>
<tr>
<td>🗞️ ⚠️</td>
<td>DB2 connections that Connection Manager discovered and that no one (not even a superuser) can remove</td>
</tr>
<tr>
<td>🗞️</td>
<td>Public DB2 connections that a superuser created</td>
</tr>
<tr>
<td>🗞️</td>
<td>Non-public DB2 connections visible to superusers, but owned by other users</td>
</tr>
<tr>
<td>🗞️ ⚠️</td>
<td>An unsupported version of a DB2 connection</td>
</tr>
</tbody>
</table>

BMC Workbench supports DB2 Version 10.1 and later.

To add a DB2 connection

You might want to give an easily identifiable name to a local DB2 connection or create a remote DB2 connection. Only you and superusers can view, use, and edit connections that you have created.

1. On the browser's main menu bar, click Tools => Manage Connections.

2. Click +.

3. Complete the Add DB2 Connection dialog box:
   a. Enter a name that describes the connection.
   b. Select a local subsystem.
If you want to connect to a remote subsystem, enable **Remote Subsystem** and select from the menu a remote subsystem that is connected to the selected local subsystem.

**(superusers only)** Select **Public** if you want to enable creating public connections that all users can use.

Click **OK**.

**To remove a DB2 connection**

You cannot remove a DB2 connection if a workspace is using it. Also, unless you are a superuser, you can edit or remove only DB2 connections that you created. See **Table 1 on page 25**.

1. On the browser's main menu bar, click **Tools => Manage Connections**.
2. Select a DB2 connection that you can edit.
3. **Click ![Delete](delete.png)**.
4. When asked to confirm, click **Yes**.

**To edit the list of favorite DB2 connections**

You can filter the list of favorite DB2 connections to display only those that are relevant to you. This list populates the menu of DB2 connections from which you select a connection. Until you make a selection, all available connections are dimmed.

**Tip**

In many dialog boxes where you must select a DB2 connection, you can also edit the list of favorites by clicking ![Favorite](favorite.png) next to the **DB2 Connection** field.

1. On the browser's main menu bar, click **Tools => Manage Connections**.

The Connection Manager displays all subsystems that are automatically discovered, public DB2 connections, and any DB2 connections that you create.

- ![Favorite](favorite.png) next to a DB2 connection indicates that the DB2 connection is included in the list of favorites. This icon is dimmed ( ![Not Favorite](not_favorite.png) ) if the connection is excluded from the list.
- 🔴 indicates a connection to an unsupported DB2 version. (BMC Workbench supports DB2 Version 10.1 and later.)

---

**Tip**

Click ![connection icon] to update the list of discovered subsystems. For example, you might update the list after restarting a DB2 server, or to see public connections that a superuser has added during your session.

---

2 Select a DB2 connection and use the command bar to edit the list of favorite connections:

- ![include icon] to include a connection in the list.
- ![exclude icon] to exclude a connection from the list.

3 Continue adding or excluding connections in your favorites list, and click **OK** when finished.

---

### Selecting a subsystem for the BMC Workbench repository

Product information, such as user preferences and workspaces, is saved in a repository on a DB2 subsystem.

Only BMC Workbench superusers (see “Managing user access” on page 22) can select the DB2 subsystem where the repository is installed.

---

**Tip**

After you have stored user preferences and workspaces, **BMC recommends that you do not change where the repository is installed**. If you have to change your repository, contact BMC Support for advice.
Consider the following guidelines if you have BMC Workbench installations sharing a single repository:

- You should have only one UIM HFS data set per repository. If multiple UIMs share a repository, they must also share the UIM HFS data set.
- All BMC Workbench installations must have the same maintenance level (that is, the same PTFs applied).

To select the subsystem

1. On the browser's main menu bar, click **Tools => Server Setup**.
2. Select **Workbench Repository**.
3. Select a DB2 subsystem and click **OK**.

### Managing a workspace layout

Use the following procedure to define the layout of perspectives for each workspace and template. You define the order and specify the perspectives displayed in the layout. BMC Workbench provides two predefined layouts, and you can create more according to your own requirements.

**Note**

Customizing the layout of one workspace does not affect any other workspaces. You can save the workspace layout with a name to use in other workspaces. For more information, see “Setting BMC Workbench options” on page 31.

To manage a workspace layout

1. In the Workspace Manager, open the workspace for which you want to customize the layout.
2. Near the top-right corner of the main console, click the **Layout** button.
3. In the **Layout** field, either accept the default, select a saved layout, or select one of the following predefined layouts to use as a starting point:
- Workbench Basic includes the DB2 Navigator, File Locator, Job Browser, Performance, and Scratchpad perspectives.

- Workbench Advanced includes all perspectives.

4. Select or clear check boxes to add or remove the corresponding perspectives from the layout.

5. (optional) To change the order in which a perspective is displayed, select the perspective and click the Up or Down arrow (↑ ↓) to move it.

6. Click OK.

## Viewing messages and UIM properties

Use the following procedure to view the system information, warning, error, and debug messages. You can also view the properties of the User Interface Middleware (UIM) server that is connected to your DB2 server.

### To view messages

1. On the BMC Workbench console's main menu, click **Tools => View Messages**.

   The View Messages screen displays messages chronologically. By default, only system messages are displayed.

2. Perform any of the following tasks:

   - To view debug messages, select **Show debug messages**.

   - To refresh the display, click **Refresh**.

   - To change the size of the View Messages screen, click and drag the screen's bottom right corner.

   - To save the messages, click **Save Messages**.

     Only the currently displayed messages are saved. Debug messages are saved only if **Show debug messages** is selected.

   - To clear the message display, click **Clear Messages**.
To view UIM details

1. On the BMC Workbench console’s main menu, click **Tools => Server Setup**.

2. Select **Server Information**.

   The properties of the UIM server are displayed.

## Preparing for maintenance

When the DB2 subsystem that hosts the repository is offline for maintenance, the repository is unavailable. Use the following procedure to maintain access to repository information, such as preferences, templates, and saved workspaces.

**Note**

You can skip this procedure if you do not need access to the repository. For example, you can skip it but continue using BMC Workbench if you do not need to access information, save workspaces, or create connections through Connection Manager.

### To prepare for DB2 maintenance

1. Migrate the data by unloading it from the current subsystem and loading it on the fallback subsystem.

2. Run Runstats on the fallback subsystem.

3. Log on to BMC Workbench as a superuser and select the fallback DB2 subsystem as the repository.

   See “Selecting a subsystem for the BMC Workbench repository” on page 27.

**Note**

Consider the following guidelines if you have BMC Workbench installations sharing a single repository:

- You should have only one UIM HFS data set per repository. If multiple UIMs share a repository, they must also share the UIM HFS data set.

- All BMC Workbench installations must have the same maintenance level (that is, the same PTFs applied).

After the maintenance is complete, repeat the procedure with the original subsystem as the recipient.
Setting BMC Workbench options

Use the following procedure to enable certain settings and troubleshooting tools that affect all perspectives.

*Note*

To set options for a particular perspective only, use the Options button. The Support tab provides access to product trace options. Use these options only when requested to do so by BMC Support.

**To change the filter options**

1. On the browser's main menu bar, click **Tools => Options**.

2. Select the General tab.

3. Select Filter Options. In all perspectives, this option converts all entered filter values to uppercase.

   *Note*
   
   After selecting (enabling) this option, you can override it for a specific filter by beginning the filter value with a quotation mark ("odable).

   - Leave the check box selected if you want BMC Workbench to convert all filter values that you enter to uppercase (the default).
   
   - Clear the check box if you want to preserve the case that you use when typing filter values.

**To save a layout**

You can save a workspace layout for use on other workspaces.

1. On the browser's main menu bar, click **Tools => Options**.

2. On the Layouts tab, next to the layout you want, click **Save the current workspace layout as**.

3. Enter a name for the layout.

4. Click **OK**.
To copy a layout

Use the following procedure to create a new layout based on an existing one. You will copy the layout, customize it, and save it under a new name.

Tip

You cannot edit the BMC predefined layouts, but you can copy and customize a predefined layout.

1. On the browser's main menu bar, click Tools => Options.

2. On the Layouts tab, select a layout.

3. Click Copy the selected layout.

4. Enter a name for the new layout.

5. In the Copy Layout dialog box, select or clear the checkbox to add or remove perspectives.

6. (optional) To change the order in which a perspective is displayed, select the perspective and click the Up or Down arrow to move it.

7. Click OK.

To set the default layout

The default layout is used when you create a new workspace, or when you open a workspace or template that was created by a version of BMC Workbench that did not support layouts.

1. On the browser's main menu bar, click Tools => Options.

2. On the Layouts tab, click Select as your default layout next to the layout that you want.

   The default layout is indicated with the icon.

3. Click OK.
Managing workspaces

In BMC Workbench for DB2, you perform all of your activities in workspaces. Use the Workspace Manager to create and manage your workspaces.

After installing and logging on to BMC Workbench, you must create a workspace before you can start using the product. Each workspace has a customizable set of perspectives, and each perspective can contain one or more views.

Creating a workspace

In BMC Workbench for DB2, you can create an entirely new workspace, create a workspace from a template, or copy an existing workspace.

For more information, view the Quick Course "Workbench for DB2 - Creating a Workspace."

The Workspace icon indicates the current status of the workspace:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Workspace status</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New workspace" /></td>
<td>New workspace</td>
<td>The workspace has been created and is unsaved.</td>
</tr>
<tr>
<td><img src="image" alt="Open workspace" /></td>
<td>Open workspace</td>
<td>The workspace has been opened in this session.</td>
</tr>
<tr>
<td><img src="image" alt="Edited workspace" /></td>
<td>Edited workspace</td>
<td>Unsaved changes have been made to the workspace.</td>
</tr>
<tr>
<td><img src="image" alt="Inactive workspace" /></td>
<td>Inactive workspace</td>
<td>The workspace has not been opened in this session.</td>
</tr>
</tbody>
</table>
Creating an entirely new workspace

Use the following procedure to create a new workspace that is not based on a template or an existing workspace.

To create an entirely new workspace

1. In the Workspace Manager, click Add Workspace.

2. In the Add Workspace dialog box, enter a workspace name and (optionally) a description for the workspace.

   The name of the workspace must be unique for the user ID.

   **Note**

   In the Workspace Manager, the asterisk beside the workspace name indicates that the workspace is new or contains unsaved changes. The Workspace icon is displayed as.

3. In the Layout field, accept the default layout or select the initial layout for this workspace.

   You can select a saved layout or one of the following predefined layouts:

   - **Workbench Basic** includes: DB2 Navigator, File Locator, Job Browser, Performance, and Scratchpad.
   - **Workbench Advanced** includes all the perspectives.

   You can edit the layout later. For details, see “Managing a workspace layout” on page 28.

4. Click Ok.
Click **Save Workspace** to save the workspace.

The Workspace icon is displayed as [Workspace Icon].

**Where to go from here**

After you create a workspace, you can perform the following tasks:

- “Discovering DB2 subsystems” on page 47
- “Tuning SQL” on page 71
- “Working with commands” on page 61
- “Managing JES jobs” on page 145
- “Managing data sets” on page 147

**Related Information**

- “Creating a workspace from a template” on page 35
- “Overview of workspaces and perspectives” on page 16
- “Creating a new DB2 object view” on page 47
- “Managing workspaces” on page 33

### Creating a workspace from a template

Use the following procedure to create a new workspace from any template that is stored in the template repository.

**To create a workspace from a template**

1. From the Workspace Manager, click **Create Workspace from Template**.

2. In the Create Workspace from Template dialog box, search for the required template:
From the **Filter by owner** menu, select a user name. Only the templates belonging to the selected user are displayed. You can use this filter in combination with the search string.

---

**Note**

identifies templates that you created

---

Enter a search string into the search field. As you enter the search string, matching folders and templates are displayed in a search list.

Use the vertical scroll bar or the mouse to navigate to and select the template that you want from the list.

Select the folder that contains the required template, and expand the folder to search within it.

---

**Tip**

Hovering over the template's name lets you see the template's owner and description, and when it was last modified.

---

**Note**

In this dialog box, you can also create new folders, or move and edit folders. For more information, see “Managing folders” on page 41

---

3 Enter a workspace name and (optionally) a description.

The workspace has the same layout as the template. You can edit the layout later. For details, see “Managing a workspace layout” on page 28

4 Click **Create Workspace**.

---

**Note**

In the Workspace Manager, the asterisk beside the workspace name indicates that the workspace is unsaved or contains unsaved changes.

---

The Workspace icon is displayed as 🗄.

---

5 Click **Save Workspace** 📁.

The Workspace icon is displayed as 🗄.
Where to go from here

After you create a workspace, you can perform the following tasks:

■ “Discovering DB2 subsystems” on page 47
■ “Tuning SQL” on page 71
■ “Working with commands” on page 61
■ “Managing JES jobs” on page 145
■ “Managing data sets” on page 147
■ “Managing a workspace layout” on page 28

--- Related Information ---

■ “Creating a workspace from a template” on page 35
■ “Overview of workspaces and perspectives” on page 16
■ “Creating a new DB2 object view” on page 47
■ “Managing workspaces” on page 33

Saving a workspace

Saving a workspace enables you to close a workspace or log out from BMC Workbench and return later to use the same defined definitions. If you do not save the workspace, any changes or additions that you made will be unavailable next time you log on to the console.

--- Note ---

All unsaved workspaces are indicated by an asterisk beside the workspace name, and the Workspace icon is displayed as a new workspace or an edited workspace .

To save a workspace

1 Select a workspace.
2 Select one of the following options:

- **Save a Workspace**

- **Save All Workspaces**

- **Save Workspace As** to save under a different name

- **Create Template** to save the workspace as a template that others can find and copy (as explained in “Creating a template” on page 42)

This option does not save the workspace itself. If you have not saved changes to the workspace, remains.

### Opening a workspace

You can open any workspace from the Workspace Manager.

**Note**

The last active workspace is displayed when you reopen BMC Workbench.

### To open a workspace

1 In the Workspace Manager, perform one of the following actions:

- Double-click the workspace.

- Select the workspace from the list, and click **Open Workspace**.

The selected workspace opens in the DB2 Navigator perspective, and workspaces that were previously saved are opened in the perspective that was active when saved.

**Tip**

In the Workspace Manager, hovering over a workspace name lets you see the workspace's owner and description, and when it was last updated.

### Where to go from here

You can add or remove views from the workspace.
Related Information

- “Creating a DB2 statement cache view” on page 52
- “Creating a new DB2 object view” on page 47
- “Removing a view” on page 53

Closing a workspace

Use the following procedure to close a workspace.

**Note**
Next time you open the workspace, BMC Workbench will display the perspective that was active when the workspace was last saved.

**To close the workspace**

1. Click Close workspace (positioned near the console's top-right corner).

   **Note**
   If the workspace has unsaved work, you are asked *if you want to close the workspace and discard your changes.*

Removing a workspace

Use the following procedure to remove or delete a workspace that you no longer need.

**To remove a workspace**

1. In the Workspace Manager, select the workspace that you no longer need.

2. Click Remove Workspace.

3. When asked to confirm, click Yes.
Editing workspace properties

Use the following procedure to change a workspace's name or description.

**To edit workspace properties**

1. In the Workspace Manager, select the workspace.

2. Click *Edit Workspace Info*.

   The Edit Workspace Info dialog box is displayed.

3. Make changes to the name, description, or both.

4. Click *OK*.

---

**Related Information**

- “Saving a workspace” on page 37

---

Working with templates

You can use any workspace as a template, and you can create new workspaces from templates that you or other users have created. Each template contains a set of views.

All templates are saved to a repository database and are available to all BMC Workbench users who have suitable DB2 authorization to access the repository.

For more information, view the Quick Course "Workbench for DB2 - Using the Template Manager."

---

**Example**

A DBA creates a workspace that includes a set of filters for DB2 Navigation; the filters specify a specific set of tables for accounting software that runs on a specific DB2 subsystem. The DBA saves the workspace as a template. The template is then available to all users, which saves the time and effort that would be required to create the workspace again from scratch.
Managing folders

Use the following procedures to create, delete, move, and rename folders.

Templates are saved to public folders, which can contain templates of one or more users. You can also add, delete, and edit folders when you create a workspace from a template or create a template.

**To create a folder**

Any user can create a folder, and other users can access and use the created folder.

1. On the browser's main menu bar, click **Tools => Manage Templates**.

   A folder tree displays all templates stored in the repository.

2. Navigate to and select the folder that will contain the new folder, or select **Templates** to create the new folder at the root level.

3. Click ✓.

4. Enter a valid folder name (up to 50 alphanumeric characters).

   The name is not case sensitive, and it can include spaces, dashes, or underscores. Any leading or trailing spaces will be removed.

5. Click **OK**.
**To delete a folder**

You can delete any empty folder.

1. On the browser's main menu bar, click **Tools => Manage Templates**.
2. In the folder tree, navigate to and select the folder to be deleted.
3. Click 
4. When asked to confirm, click **Yes**.

**To move a folder**

1. On the browser's main menu bar, click **Tools => Manage Templates**.
2. In the folder tree, select the folder that you want to move.
3. Click 
4. Select a new parent folder.
5. Click **OK**.

**To change a folder name**

1. On the browser's main menu bar, click **Tools => Manage Templates**.
2. In the folder tree, navigate to and select the folder name that you want to change.
3. Click 
4. Enter a new valid name.
   - See “To create a folder” on page 41 for permitted characters.
5. Click **OK**.

**Creating a template**

Use the following procedure to create a template from any workspace. You or your team can make a set of templates for different purposes.
To create a template

1 In the Workspace Manager, open the workspace that you want to use as a template.

2 Click Create Template.

Note
In the Create Template dialog box, you can also create new folders and edit your folders. For more information, see “Managing folders” on page 41.

3 In the Create Template dialog box, enter a template name (up to 50 alphanumeric characters) and optionally a template description.

   The name is not case sensitive, and it can include spaces, dashes, or underscores. Any leading or trailing spaces will be removed.

   Entering a description can help other users determine whether the template suits their purposes.

4 Either navigate to and select a folder to contain the template, or click and add a new folder as described in “Managing folders” on page 41.

5 Click Create Template.

Note
The new template inherits the layout of the workspace.

Related Information

- “Creating a workspace from a template” on page 35

Removing a template

Unless you are a superuser, you can remove only templates that you own.

To remove a template

1 On the browser's main menu bar, click Tools => Manage Templates.

   A folder tree is displayed.

2 In the navigation tree, navigate to and select the template.
You can use Ctrl+Click to select more than one template.

3 Click .

4 When asked to confirm, click Yes.

Moving and editing templates

Use these procedures to move your templates between folders and edit template information.

Unless you are a superuser, you can move and edit only templates that you created.

To move a template to a different folder

1 On the browser's main menu bar, click Tools => Manage Templates.

   Tip
   You can also access the Manage Templates dialog box from the Create Template command.

2 Select your user name from the Filter by owner menu, and filter the templates so that you can see only templates that you created.

   Note
   Skip this step if you are a superuser and intend to move another user's templates.

3 If you want to move the template to a new folder, create the new folder as described in “To create a folder” on page 41.

4 Navigate to and select the template to be moved.

5 Click .

6 Navigate to and select the target folder.

7 Click OK.

To edit a template's information

1 On the browser's main menu bar, click Tools => Manage Templates.
2 Select your user name from the **Filter by owner** menu, and filter the templates so that you can see only templates that you created.

---

**Note**

Skip this step if you are a superuser and intend to move another user's templates.

---

3 Navigate to and select the template.

4 Click 

5 Edit the template's information.

6 Click **OK**.
Discovering DB2 subsystems and browsing catalogs

BMC Workbench for DB2 enables you to discover DB2 subsystems, and then browse through the DB2 catalog tables where you can select DB2 objects, view their properties, and perform actions on them.

Discovering DB2 subsystems

Sysplex discovery occurs during BMC Workbench for DB2 initialization.

BMC Workbench discovers all DB2 subsystems on the sysplex where a UIM server is installed; however, the filtering mechanism prevents you from viewing and connecting to subsystems running on DB2 versions that are not supported by BMC Workbench. If you have multiple sysplexes, you must install a UIM on each sysplex. For more information, see the Installation System documentation.

Note

BMC Workbench strictly maintains DB2 authorization rules; you can access DB2 objects on a subsystem only if you have the appropriate authorization in DB2.

Creating a new DB2 object view

Use the following procedure to create a view in a workspace. Each view contains a subset of DB2 objects retrieved from a DB2 subsystem. This topic also explains how to build an advanced search to use as the basis for the new view.

To create a DB2 object view

1. Open or create a workspace.
In the DB2 Navigator perspective, click the Add View menu arrow, and then click Add DB2 Object View.

**Tip**
You can also right-click in the DB2 navigation pane to select this action. The default value of the Add View menu is always the last option that you created. If you previously created, in this or a previous saved session, a DB2 Statement Cache view then clicking creates a new DB2 Statement Cache view.

In the Add DB2 Object View dialog box, complete the following fields or accept the displayed default values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 Connection</td>
<td>Use either of the following methods:</td>
</tr>
<tr>
<td></td>
<td>■ Type the full or partial name of a DB2 connection to select the first subsystem that matches this value in the list of favorite connections.</td>
</tr>
<tr>
<td></td>
<td>■ Use the menu arrow to select from your list of favorite connections.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong>: You can add DB2 connections to your list of favorite connections by clicking and specifying which connections to include.</td>
</tr>
<tr>
<td>Object Type</td>
<td>Select an object type.</td>
</tr>
</tbody>
</table>

Create either a basic search or an advanced search to use as the basis for the new view:

■ For a basic search, enter a filter pattern for the selected object.

■ For an advanced search, click **Advanced Search** and complete the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Label</td>
<td><em>(optional)</em> Enter a label for this view. The default name is the first 30 characters of the search clause.</td>
</tr>
<tr>
<td>String Delimiter</td>
<td>From the menu, select <strong>Apostrophe</strong>, <strong>Quotation mark</strong>, or <strong>None</strong> as the string delimiter for character-type columns.</td>
</tr>
<tr>
<td>Search clause builder</td>
<td>Build an advanced search clause as instructed in “To build an advanced search clause for a view” on page 49.</td>
</tr>
</tbody>
</table>
5 Click **OK**.

The view is now included in the DB2 navigation pane, in a hierarchical display organized by subsystem and type.

---

**Note**

(identifies a view created from a basic search, and (identifies one created from an advanced search).

6 When finished, save the workspace.

**To build an advanced search clause for a view**

The search clause is built from rows of search criteria in a grid. You can add, remove, and move rows to fine-tune the search clause.

As you enter the search criteria and build the search clause, the clause is displayed in the **Search Clause** text area below.

---

**Note**

By default, column names are displayed in catalog order. You can change to alphabetical order by clicking **Options** and changing the setting.

---

1 In the **Column** column, click the empty cell and either select a column from the displayed list or type a column name.

BMC Workbench selects a matching column name in the list based on your entry; the list includes all column names for the DB2 connection and object type.

2 In the **Operator** column, click the cell and select an operator.

---

**Note**

The LIKE operator accepts only DB2 wildcards (\% and _).

---

3 Click in the **Value** column and add a value.

The value is case sensitive and is automatically enclosed in the delimiter that you selected.
BMC Workbench requires a nonblank value but does not validate this value.

4 Click in the And/Or column and select one of the following options:
   ■ AND
   ■ OR
   ■ - (which closes the search clause)

If you select AND or OR, you are prompted to enter another column name, operator, and value in the row below.

5 Continue adding rows until you have built the search clause, ending the clause with -.

6 (optional) If you want to make any changes, edit the search criteria:

   Use the following buttons to add, remove, or move rows. (You can perform the same operations by right-clicking in a row and selecting the appropriate command.)

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="+" alt="Add Row" /></td>
<td>Adds a row to the Search Clause criteria grid</td>
</tr>
<tr>
<td><img src="%3E" alt="Add Row Above" /></td>
<td>In the grid, selecting a row and clicking <img src="+" alt="Add Row" /> adds a row above the one that you selected.</td>
</tr>
<tr>
<td><img src="%E2%88%92" alt="Remove Row" /></td>
<td>Removes the selected row from the grid</td>
</tr>
<tr>
<td><img src="%E2%86%91" alt="Move Row Up" /></td>
<td>Moves the selected row up</td>
</tr>
<tr>
<td><img src="%E2%86%93" alt="Move Row Down" /></td>
<td>Moves the selected row down</td>
</tr>
</tbody>
</table>

Note:
Changes that you type into the text area are not synchronized with the search criteria in the grid. The grid is disabled.

You can also edit the search clause directly by typing in the search-clause text area. You can use the following buttons or shortcut keys:

<table>
<thead>
<tr>
<th>Button or shortcut key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column or Alt+Ctrl+Space key</td>
<td>Click in the clause and, from the menu, select a column name to add to the search clause.</td>
</tr>
<tr>
<td>Operator or Alt+Ctrl+o</td>
<td>Click and, from the menu, select an operator to add to the search clause.</td>
</tr>
<tr>
<td>Button or shortcut key</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
<td>Click to discard any changes that you made in the text area and to re-synchronize the search clause with the search criteria in the grid. (Clicking this button again would restore your unsaved changes and disable the grid.)</td>
</tr>
</tbody>
</table>

**Note:** This button is available only after you begin making changes in the text area. Making any change in the search criteria grid disables this button.

7 When finished building the search clause, click **OK**.

---

**Related Information**

- “Overview of workspaces and perspectives” on page 16
- “Opening a workspace” on page 38
- “Creating an entirely new workspace” on page 34
- “Navigating to an object” on page 55
- “Viewing related objects” on page 56

---

**Navigating through the DB2 catalog**

Use the following procedure to select an object, and then create new views of related DB2 objects. For example, you can select a table and then create an object view of its indexes or of the database that contains the table.

**To navigate through the DB2 catalog**

1. Select or create a DB2 object view that contains the object.
   
   For details, see “Creating a new DB2 object view” on page 47.

2. Navigate to and select your source object.
   
   For details, see “Navigating to an object” on page 55.

3. From the **Navigate To** toolbar, click the required object button.

   Only object buttons related to the selected object are available.
Creating a DB2 statement cache view

You can create a view of DB2 statements from the statement cache. Then, you can select statements to view, Explain, and tune.

**To create a DB2 statement cache view**

1. Open or create a workspace.

2. In the DB2 Navigator perspective, click the Add View menu arrow, and then click **Add DB2 Statement Cache View**.

   **Tip**
   You can also right-click in the DB2 navigation pane to select this option.

   The default value of the Add View menu is always the last option that you created. If you previously created, in this or a previous saved session, a DB2 Statement Cache view then clicking creates a new DB2 Statement Cache view.

3. In DB2 Navigator, select **Add DB2 Statement Cache View**.

   **Tip**
   You can also right-click in the DB2 navigation pane to select this option.

4. Complete the Add DB2 Statement Cache View dialog box:

   a. Select a DB2 connection:

   - Type the full or partial name of a DB2 connection to select the first subsystem that matches this value in the list of favorite connections.

   - Use the menu arrow to select from your list of favorite connections.
Tip

Clicking lets you specify which DB2 connections to include in your list of favorite connections.

b Enter a filter pattern for the selected program name or package name.

5 Click OK.

The view is added into the DB2 navigation pane in a hierarchical display organized by subsystem and type.

6 (optional) To add additional filters to the same subsystem, return to Step 3 on page 52 and specify a filter.

Related Information

- “Overview of workspaces and perspectives” on page 16
- “Opening a workspace” on page 38
- “Creating an entirely new workspace” on page 34
- “Creating a new DB2 object view” on page 47
- “Viewing related objects” on page 56
- “Navigating through the DB2 catalog” on page 51
- “Tuning SQL” on page 71
- “Explaining SQL statements” on page 72

Removing a view

Use the following procedure to remove a DB2 statement cache view or DB2 object view.

To remove a view

1 Open the workspace containing the DB2 view.

2 From the DB2 navigation pane, select the DB2 view that you want to remove.
WARNING
The DB2 navigation pane displays the views in a hierarchy. Selecting a subsystem node or type node will delete all of the views for that node.

3 Click Remove View.

Tip
You can also right-click the Navigation pane and select the Remove View menu option.

4 When asked to confirm, click Yes.

Copying and pasting a view

Use the following procedures to copy and paste a DB2 statement cache view or DB2 object view.

To copy a view

1 Open the workspace containing the DB2 view.

2 From the DB2 navigation pane, select the DB2 view that you want to copy.

3 Right-click and select Copy View.

You can now paste this view.

To paste a view

1 Open the workspace containing the DB2 view.

2 On the DB2 navigation pane, select and right-click where you want to paste the view.

3 Click Paste View.

The Add Object View dialog box is displayed.

4 In the Add Object View dialog box, edit the view settings.

For more information, see “Creating a new DB2 object view” on page 47.
By default, the value of the DB2 connection field is automatically updated to match the DB2 connection under which the view is pasted.

5 Click **OK**.

### Browsing the catalog

You can browse the DB2 catalog, filter results, and view DB2 objects.

**Tip**

Click the column header to sort the contents of a table according to that column. Click again to toggle between ascending and descending order.

### Navigating to an object

Use the following procedure to search DB2 catalogs and navigate to objects that you have selected.

**Note**

To navigate to a statement, see “Selecting a statement for SQL Analysis” on page 84.

**To navigate to an object**

1 Open a workspace as described in “Opening a workspace” on page 38.

2 Use one of the following methods to navigate to the required object:

   - Add a DB2 object view containing the required object.
   - From the **Navigate To** toolbar, click an object icon to open a DB2 object view containing the required object.
   - In a view, right-click an object row, select **Navigate To**, and select the required object type.
   - In a view, click **Related Objects** to navigate to the required object type.

3 Select one or more objects from the object list.
Where to go from here

You can now view the object properties, view related objects, create a new DB2 object view using the selected object as a source, or perform commands on the selected object or objects.

--- Related Information ---

- “Viewing related objects” on page 56
- “Viewing object properties” on page 57
- “Navigating through the DB2 catalog” on page 51
- “Generating a command” on page 62

Viewing related objects

Use the following procedure to select an object and view lists of objects that are related to it. This procedure creates a related objects view.

To view related objects

1. From the DB2 navigation pane, select a view containing the source object that interests you.

2. In the results pane, select the source object.

3. From the Commands toolbar, click Related Objects.

   Tip
   You can also right-click and select View => Related Objects.

   Note
   Only buttons for valid related objects are displayed.

4. From the Related Objects toolbar, click the button of the required object.

   A list of corresponding objects is displayed in the results pane. You can select an object and use it as a source for navigation, or you can perform commands on the object.
Viewing object properties

Use the following procedure to view the properties of any object in the catalog for which you have authorization.

To view object properties

1. Select or create a workspace that contains a DB2 object view containing the object.
   
   **Note**
   
   If required, you can add a new DB2 object view.

2. Navigate to the object.

3. Perform one of the following actions:
   
   - In the Commands toolbar, click **Properties**.
   - In the results list, select and double-click the object row.
   - In the results list, select an object row, right-click and select **View => Properties**.

   The properties box of the selected object is displayed.

4. Click **OK** to close the properties box.

Exporting data

Use the following procedure to export data in `.csv` format to the location that you chose. The output includes the column headings.

To export data

1. Select or create a DB2 object view that contains the object or objects that you want to export.
For details, see “Creating a new DB2 object view” on page 47.

2 Navigate to and select your source object or objects.

For details, see “Navigating to an object” on page 55.

3 Perform one of the following actions:

■ To export all rows in the view, right-click anywhere in the results pane and select Select All; then right-click again and select Export data.

■ To export a specific object, select one or more object entries, right-click and select Export Data.

4 When prompted, select a location for the exported data.

The default file name is export_data.csv.

5 Save the file.

--- Related Information ---

■ “Copying data” on page 58

---

**Copying data**

Use the following procedure to copy data from the results pane to the clipboard.

**To copy data**

1 Select or create a DB2 object view that contains the object or objects that you want to export.

For details, see “Creating a new DB2 object view” on page 47.

2 Navigate to and select your source object or objects.

For details, see “Navigating to an object” on page 55.

3 Perform one of the following tasks:

■ To copy all rows in the view, right-click anywhere in the results pane and select Select All; then right-click and select Copy.
To copy a specific object, select one or more object entries; right-click, and select Copy.

You can now paste the data directly into a file or a spreadsheet application such as Microsoft Excel. The data automatically contains the column names.

**Related Information**

- “Editing text files in Scratchpad” on page 64
- “Exporting data” on page 57

---

## Setting DB2 Navigator options

Use the following procedure to set the behavior of certain DB2 Navigator options.

1. Select the **Options** button.
2. Select the **Commands** tab.
3. Specify your preferences, and click **OK**.

Table 2 on page 59 shows the options that you can set.

**Table 2: DB2 Navigator options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal Point</td>
<td>Select the check box if you want to use a period (.) for decimal points. Clear this check box if you want to use a comma.</td>
<td>Selected (period)</td>
</tr>
<tr>
<td>Verbose Output</td>
<td>Select this check box to run the command with output level VERBOUSE. Clear this check box to use output level TERSE.</td>
<td>Selected (VERBOSE output)</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
<td><strong>Default</strong></td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Object types</td>
<td>Select the object types that you want to include in the HDDL output. Clear the check box for any object type that you want to omit. You can select the following object types:</td>
<td>All selected except <strong>Auths</strong></td>
</tr>
</tbody>
</table>
|                      | ■ Table spaces  
|                      | ■ Tables  
|                      | ■ Foreign keys  
|                      | ■ Views  
|                      | ■ Indexes  
|                      | ■ Synonyms  
|                      | ■ Aliases  
|                      | ■ Plans  
|                      | ■ Triggers  
|                      | ■ Auths                                                                                                                                           |                               |
| Define (HDDL and DDL only) | Select this check box if you want to include the DEFINE parameter in DDL or HDDL for a table space or index. Clear the check box to omit the parameter.                                      | Not selected                  |
| SQLID before Grant (DCL only) | Select this check box to generate a SET CURRENT SQLID= grantor statement before each GRANT statement. This option is used for processing HDDL with AUTHs, HGRANT, and CASCADE REVOKE REASSIGN. Clear the check box to omit the statement. | Not selected                  |
Working with commands

You can edit and run many common commands directly from the BMC Workbench product's Scratchpad editor, a full-featured editing tool.

The typical workflow involves completing these tasks:

1. “Navigating to an object” on page 55
2. “Generating a command” on page 62
3. “Editing text files in Scratchpad” on page 64
4. “Running a command from Scratchpad” on page 67

Supported commands

This topic describes the supported commands that you can edit and run directly from BMC Workbench for DB2.

**Note**
The HDDL command is available if you have a valid license for the BMC Object Administration for DB2 solution.

<table>
<thead>
<tr>
<th>Command</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alter</td>
<td><img src="image" alt="Alter Button" /></td>
<td>Opens an ALTER editor view for the selected database, table space, table, or index. For more information, see “Generating and running Alter DDL statements” on page 63.</td>
</tr>
<tr>
<td>DDL</td>
<td><img src="image" alt="DDL Button" /></td>
<td>Displays the Data Definition Language (DDL) for a selected object.</td>
</tr>
<tr>
<td>HDDL</td>
<td><img src="image" alt="HDDL Button" /></td>
<td>Displays the Hierarchical Data Definition Language (HDDL) for the selected object and its dependents.</td>
</tr>
<tr>
<td>Command</td>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>DCL</td>
<td>![dcl]</td>
<td>Displays the Data Control Language (DCL) for the selected object</td>
</tr>
<tr>
<td>DROP</td>
<td>![drop]</td>
<td>Displays the DROP command for the selected object</td>
</tr>
<tr>
<td>BIND</td>
<td>![bind]</td>
<td>Displays the BIND command for the selected package, plan, or collection ID</td>
</tr>
<tr>
<td>REBIND</td>
<td>![rebind]</td>
<td>Displays the REBIND command for the selected package, plan, or collection ID</td>
</tr>
<tr>
<td>FREE</td>
<td>![free]</td>
<td>Displays the FREE command for the selected package or plan</td>
</tr>
<tr>
<td>DISPLAY</td>
<td>![display]</td>
<td>Displays the status of the selected object</td>
</tr>
<tr>
<td>START</td>
<td>![start]</td>
<td>Displays the START command for a database, table space, table, index, view, or stored procedure</td>
</tr>
<tr>
<td>STOP</td>
<td>![stop]</td>
<td>Displays the STOP command for a database, table space, table, index, view, or stored procedure</td>
</tr>
<tr>
<td>SELECT</td>
<td>![select]</td>
<td>Displays the SELECT command for a table, alias, or view</td>
</tr>
<tr>
<td>INSERT</td>
<td>![insert]</td>
<td>Displays the INSERT command for a table, alias, or view</td>
</tr>
<tr>
<td>UPDATE</td>
<td>![update]</td>
<td>Displays the UPDATE command for a table, alias, or view</td>
</tr>
<tr>
<td>DELETE</td>
<td>![delete]</td>
<td>Displays the DELETE command for a table, alias, or view</td>
</tr>
</tbody>
</table>

**Generating a command**

Use the following procedure to generate a command for a selected object. The generated command is displayed in Scratchpad.

For more information, view the Quick Course "Workbench for DB2 - Generating DML."
To generate commands

1 In the DB2 Navigator perspective, select the required object or objects (up to five).

For more information, see “Navigating to an object” on page 55.

The command tool bar displays valid command buttons for the selected objects. See “Supported commands” on page 61.

For more information, view the Quick Course "Workbench for DB2 - Executing DB2 Commands."

2 Click the relevant command button.

The Scratchpad perspective opens to display the SQL statement in the Command Text tab. If you selected multiple objects, the SQL statements or commands are displayed consecutively in the Scratchpad.

3 You can now edit the SQL statement or command, as described in “Editing text files in Scratchpad” on page 64.

Related Information

- “Supported commands” on page 61

Generating and running Alter DDL statements

BMC Workbench lets you generate and run an Alter DDL statement for databases, table spaces, tables, and indexes. You must have the required DB2 system privileges to make these changes.

For more information, view the Quick Course "Workbench - Altering objects."

To generate and run an Alter DDL statement

1 In the DB2 Navigator perspective, select the database, table space, table, or index.

For more information, see “Navigating to an object” on page 55.
In the Tasks tool bar, click Alter.

Tip
You can also right-click on the object and select from the menu.

An Alter editor view is displayed in the Schema Management perspective.

Make any needed changes to the editable properties.

Note
Additional displayed panels also let you change the properties of the object's subelements, such as table columns or index partitions.

When you make changes to a property, the name of the changed property field is italicized.

Click Generate Alter DDL.

The DDL is displayed in the Alter DDL tab.

Click to run the DDL statement.

Tip
The Alter DDL tab closes when you return to the General tab. If you want to make more changes, click to reload the object definition and continue.

Editing text files in Scratchpad

Use the following procedure to edit a text file (such as a command statement) that is opened in Scratchpad.

To edit a file

1 To open the text file in the Scratchpad perspective, perform one of the following actions:
   - In the Scratchpad perspective, open an existing file displayed under Files.
To create a new command file, add a new file view by clicking +. Then, in the Command Text tab in Scratchpad, enter the command text (either by typing it or pasting copied text).

Select an object or group of objects in the DB2 navigation perspective, and click one of the command options such as DDL.

Double-click a data set in the File Locator perspective.

In the Scratchpad's Command Text tab, edit the command as needed:

Table 3: Scratchpad commands

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find a search string</td>
<td>Enter the search string in the Search box and click Find.</td>
</tr>
</tbody>
</table>
| Find and replace a search string        | 1 Double-click a data set in the File Locator  
                                          | 2 Enter the search string in the Search box.  
                                          | 3 Enter the replacement string in the Replace box.  
                                          | 4 Click Find.  
                                          | 5 Click Replace. |
| Find and replace all instances of a search string | 1 Enter the search string in the Search box.  
                                          | 2 Enter the replacement string in the Replace box.  
                                          | 3 Enable the All checkbox.  
                                          | 4 Click Replace. |
| Make a search case sensitive            | Select the A/a checkbox.                     |
| Undo an action                          | Click ⬅️ to undo the last action.            |
| Redo an action                          | Click ⬅️ to cancel undoing the last action.  |
| Enable the editor to accept Regular expressions | Select the RegEx checkbox.  
                                          | **Note:** Scratchpad supports all standard Regular expressions. |
To copy an existing file:

1. Browse to a data set and open an existing file.
2. Click **Copy File**.
3. Save the file.
   Follow the instructions in Step 4 on page 66.

**Note**
To remove a file view from the Scratchpad navigator pane, select the file view and click **Remove File View**.

3. Save your changes:
   - To save the active edited command output, click **Save File** in the toolbar.
   - To save multiple open files (for example, you selected and created DDL for several objects simultaneously), click **Save all files** (in the navigation pane) to open a Save dialog box for each file.

**Note**
For each file, you can save to a separate data set or select **Don't Save**.

Under **Files** in the navigation pane, Scratchpad automatically displays all files that are saved to the mainframe.

4. Select a z/OS data set in which to save the file.
   a. Click **Add Data Set Filter**.
   b. In the **Filter Pattern** box, enter a filter (the wildcard * is supported) to display a filtered list of data sets that includes the one you want.
   c. In the displayed hierarchical tree, navigate to and select the data set that you want.

   If you select an archived data set, you will be asked to confirm that you want to restore that data set. If the data set has been archived, you are asked if you want to restore it.

5. Enter a file name.
Creating commands

Use the following procedure to create a command.

1. Click the Scratchpad perspective tab.
2. Click Add File View.
3. In the Command Text tab in Scratchpad, enter the command text (either by typing or by pasting copied text).
4. Edit the command, if needed, as explained in “Editing text files in Scratchpad” on page 64.
5. Run the command.

For more information, see “Running a command from Scratchpad” on page 67.

All files containing commands can be saved to the mainframe and are displayed in the Scratchpad navigation pane under Files.

Running a command from Scratchpad

Use the following procedure to run one or more commands directly from the Scratchpad perspective. If Scratchpad is displaying multiple commands, you can run all of them, or select and run a single command.
To run a command

1. Enter the command or commands into Scratchpad.
   The source can be either:
   - A command that you pasted or typed into Scratchpad and then edited.
   - A command that you generated from DB2 objects.

2. Perform one of the following tasks:
   - To run one command from a group displayed in Scratchpad, select the command and click Run Selected.
   - To run all commands displayed in Scratchpad, click Run.

   **Note**
   Any existing output is discarded when you run the commands again.

3. Select the DB2 subsystem on which to run the command. Guidelines are as follows:
   - By default, the last-executed DB2 connection is pre-selected.
   - Type the full or partial name of a DB2 connection to select the first subsystem that matches this value in the list of favorite connections.
   - Use the menu arrow to select from your list of favorite connections.

   **Tip**
   Click and specify which DB2 connections to include in your list of favorite connections.

   The status bar at the bottom of the screen indicates whether the command runs successfully. The Output tab displays a summary for each command that you ran.

4. To view results, perform one of the following tasks:
   - To view all results, click View All Result Sets.
To view the result set for a specific command, on the Output tab, click the relevant **View Result Set**.

**Tip**

If the command failed to run successfully, click **View Messages** to see all error messages, or click **on the Output tab to view error messages for a specific command.** Also, note that **View All Result Sets** and **View Output Text** are enabled only when the Output tab is active.

5. Save the results as a text file on your local file system:

   a. Click the Output tab and in the tool bar, then click **View Output Text** in the tool bar.

   b. Click **.

**Related Information**

- **“Supported commands” on page 61**

---

**Setting Scratchpad options**

When the Scratchpad perspective is open, clicking the Options button lets you set the Scratchpad options.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop Recovery</td>
<td>This option lets you restore dropped objects from the CATALOG MANAGER product via the Drop Recovery command. <strong>Note:</strong> This option is available only if you have a valid license for the BMC Object Administration for DB2 solution.</td>
<td>No</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Default value</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
</tbody>
</table>
| Select Options | For SELECT statements, this option lets you set maximum values for the following items (with defaults shown in parentheses):  
  ■ Maximum numeric length (10)  
  ■ Maximum CHAR length (64)  
  ■ Maximum VARCHAR length (64)  
  ■ Maximum select rows (300), where 0 returns all rows in the result set.  
  **Note:** The total amount of returned data in the result set cannot exceed 50 MB; the Select Options settings do not affect that limit. If the limit is reached, the product alerts you with a message. | N/A           |

---

**Related Information**

- “Supported commands” on page 61
Tuning SQL

You can create one or more What-If statements and use them to progressively tune a selected baseline statement.

By default, BMC Workbench for DB2 honors the DB2 privileges to generate Explain plans. To configure BMC Workbench to use Install SYSADM for executing Explains, see information about the authexpl option in the BMC Products and Solutions for DB2 Customization Guide.

Tuning SQL workflow

The workflow for tuning a SQL statement typically includes the following steps:

To tune a SQL statement

1. Select a SQL statement to be used as the baseline statement (“Selecting a statement for SQL Analysis” on page 84).
2. Perform an Explain on the statement (“Explaining SQL statements” on page 72).
3. Create a What-If scenario based on the baseline statement (“Creating a What-If scenario” on page 73).
4. Compare the cost of the statements (“Comparing statements” on page 82).
5. Create a new What-If scenario.
6. Continue the process until you have optimized the statement.

For more information, view the Quick Course "Workbench for DB2 - Analyzing SQL Performance."
Explaining SQL statements

The Explain command explains the steps that the DB2 optimizer must take to execute the selected SQL statement.

SQL Explain displays the cost for each step of the SQL statement and the total cost of the entire statement. This data enables you to determine which part of the statement is estimated to consume the most resources.

An Explain takes one of the following forms:

- A dynamic Explain that asks the DB2 optimizer for an explanation of the access path. This process evaluates access paths, SQL text, and key catalog statistics in real time.

- A static Explain from a bind with EXPLAIN(YES). This process reports the access path information that was derived when you performed a bind with EXPLAIN(YES).

- An Explain Statement Cache on a dynamic SQL statement. This process performs an EXPLAIN STMTCACHE STMTID on a dynamic SQL statement that was executed and is still in the statement cache. The access path used at the time that the statement was executed is retrieved from the statement cache and reported on.

- An Explain Package, in which the current access path for a static SQL statement is retrieved and reported on even if a BIND with EXPLAIN(YES) was not previously performed.

Note

By default, BMC Workbench for DB2 honors the DB2 privileges to generate Explain plans. To configure BMC Workbench to use Install SYSADM for executing Explains, see information about the authexpl option in the BMC Products and Solutions for DB2 Customization Guide.

The resulting Explain plan is the hierarchical representation of rows extracted from the DB2 plan table.

To Explain a SQL statement

1. Use any of the following methods to select a SQL statement as the baseline statement.

   - “Selecting a statement from the DB2 statement cache” on page 84
   - “Selecting a statement from a DB2 package” on page 85
   - “Selecting an ad hoc statement” on page 86
The Performance perspective displays the SQL statement and its parameters. For more information, see “Explain tab” on page 92.

2. Click **Generate explain plan**.

The Explain results are displayed along with the following tabs:

- **SQL** (see “SQL tab” on page 90)
- **Indexes** (see “Indexes tab” on page 91)
- **Explain** (see “Explain tab” on page 92)
- **Cost** (see “Cost tab” on page 94)
- **Predicates** (see “Predicates tab” on page 94)
- **Compare** (see “Compare tab” on page 95)

**Note**

The Compare tab is dimmed until you generate the first What-If scenario.

- **Catalog Objects** (see “Related Objects tab” on page 95)

### Using What-If scenarios

The What-If scenarios enable you to edit a statement, add or drop indexes, execute Explain, and compare the results of the statement to another statement.

### Creating a What-If scenario

Use the following procedure to create a What-If scenario from a source statement and then compare it to Explain results.

**To create a What-If scenario**

1. In the Performance perspective, select the source statement from a Tuning session.
You can use a baseline statement (identified by [?] or one of the What-If scenarios that you have previously created (identified by [?] ).

The SQL tab displays the details of the source SQL statement.

2 Click What-If [?].

3 (optional) On the SQL tab, enter a unique name for the What-If scenario.

If you do not give the scenario a new name, by default an incremental number is added as a suffix to the source statement name.

a Edit the details of the scenario.

You can change the DB2 connection, table qualifier, Explain type and degree.

Click [?] and specify which DB2 connections to include in your list of favorite connections.

b Edit the SQL statement.

4 (optional) On the Indexes tab, modify the indexes.

For more information, see “Creating and editing a What-If index scenario” on page 75.

5 When finished, click Generate explain plan [?].

Where to go from here

You can now compare this What-If scenario with another scenario or baseline statement.

--- Related Information ---

- “Comparing statements” on page 82
Creating and editing a What-If index scenario

Use the following procedure to evaluate how adding an index, dropping an index, or updating index statistics would affect a statement's performance.

**Before you begin**

The What-If index feature is available only if you have a valid license for the BMC Performance for DB2SQL solution.

For more information, view the Quick Course "Workbench for DB2 - Using What-if Index."

**To create a What-If index**

1. In the Performance perspective, select the source statement.

   You can use a baseline statement (identified by ![baseline icon]) or a previously created What-If scenario (identified by ![question mark icon]).

   The SQL tab displays the details of the source SQL statement.

2. If the selected statement has not been explained, click ![explain icon] to Explain it.

3. Click **What-If**.

4. *(optional)* Enter a unique name for the new scenario.

   **Note**

   If you do not enter a name, the scenario uses the source statement's name with an incremental number added as a suffix.

5. Click the Indexes tab.

   **Note**

   For more information, see “Indexes tab” on page 91. The Indexes tab is available only if the baseline statement was successfully explained.

   The Indexes tab includes these items:
Command buttons enable you to add, drop, edit, or copy indexes from the What-If statements.

The Tables pane lists all tables that are referenced in the SQL statement.

The Indexes pane lists the indexes of the selected table (initially the top entry in the list).

**Note**

identifies indexes that the Explain plan uses.

6 From the Tables pane, select the table that contains the index that you want to edit.

7 From the Indexes pane, select the index.

Perform any of the following actions to set up the scenario that you want to evaluate:

- Add a new index for the selected table (as explained in “Adding an index to a What-If scenario” on page 77).

- Copy an existing index and modify the copy (“Copying an index for a What-If scenario” on page 80).

- Edit an existing index (“Editing an index for a What-if scenario” on page 81).

- Drop an index (“Dropping an index from a What-If scenario” on page 79).

- Revert any changes made to the catalog by clicking **Revert**.

- Generate statements to reflect changes for this What-If index scenario (“Generating a tuned statement” on page 82).

**Note**

You cannot make changes to the baseline statement.

8 Click to explain the edited What-If scenario.

**Note**

You cannot edit the What-If scenario after it is explained.

9 Compare the resulting scenario with the baseline or with another What-If scenario as explained in “Comparing statements” on page 82.
10 Continue from Step 7 on page 76 until you have fully tuned the statement.

11 If you want to generate the tuned statement, click Generate to copy the DDL.

For more information, see “Generating a tuned statement” on page 82.

--- Related Information ---

- "Working with commands" on page 61

---

### Adding an index to a What-If scenario

Use the following procedure to add a What-If index to a selected table and evaluate how the change would affect the SQL statement's performance.

--- Note ---

You cannot add an index to the baseline statement (identified by ).

---

**To add a new index**

1. Select the table as described in “Creating a What-If scenario” on page 73.

2. Click Add.

3. In the Index Attributes dialog box, define the new index:
   a. At Index name, enter the name that you want to use.
   b. At Unique rule, accept the default (Duplicate) or select Unique or Unique unless Null.
   c. Select the corresponding check boxes if you want the index to be clustering, partitioned, or padded.
   d. Click Next.

4. In the Key Columns dialog box, define the key columns for the index:
   a. Add columns or remove available columns from the Selected Columns pane.
   b. If you want to reorder a column, select it and use the Up or Down button to change the column's position.
c If you want to add an index on expression, click + and enter an expression. Then, click OK.

You can enter any valid standard expression that SQL supports.

--- Tip ---

To remove an index on expression, click -.

d Click the arrow that indicates to sort the columns in ascending, descending, or random order.

e Click Next.

5 In the Index Statistics dialog box, define the statistics for this index:

a At First key cardinality, enter a positive integer (default 0) or -1 (indicating that no statistics have been gathered).

b At Full key cardinality, enter a positive integer (default 0) or -1 (indicating that no statistics have been gathered).

c At Cluster ratio, enter a number between 0 and 1 (default 0.8) or -2 (indicating that no statistics have been gathered).

d At Leaf pages, enter a positive integer or -1 (the default, indicating that no statistics have been gathered).

e At Number of Levels, enter the number of required levels (default -1).

f Click Finish.

The wizard closes, and the results pane shows the new index with + beside it.

Where to go from here

You can now Explain and compare the new scenario.
Dropping an index from a What-If scenario

Use the following procedure to evaluate how dropping an index would affect the performance of a SQL statement.

**Note**

You cannot add an index to the baseline statement (identified by 🟡).

**To drop an index**

1. Create a What-If scenario and select an index.
   
   For more information, see “Creating a What-If scenario” on page 73.

2. Click **Drop**.

   The **Indexes** pane displays 🟡 next to the dropped index.

3. Click 🚨 to Explain the statement.

4. *(optional)* Select an index and click **Revert** to return indexes that you have dropped.

**Where to go from here**

Explain and compare the scenario after you have completed editing.
Copying an index for a What-If scenario

Use the following procedure to copy an index, edit it, and save it as a What-If index in a What-If scenario.

**Note**

You cannot add an index to the baseline statement (identified by ![baseline icon]).

**To copy an index**

1. Create a What-If scenario and select an index.
   
   For more information, see “Creating a What-If scenario” on page 73.

2. Click **Copy**.

3. In the Index Attributes dialog box, change the name and edit any other index attributes.
   
   For more information, see “Adding an index to a What-If scenario” on page 77.

4. Click **Finish**.

   The wizard closes, and the results pane shows the new index with ![+ icon] beside it.

**Where to go from here**

You can now Explain and compare the scenario after you have completed editing.
Editing an index for a What-if scenario

Use the following procedure to edit an index and evaluate the effect on the SQL statement's performance.

**Note**

You cannot edit the columns of an index in the baseline statement (indicated by 🧠), but you can make changes to the index attributes and statistics.

**To edit an index**

1. Select an index.
   
   For more information, see “Adding an index to a What-If scenario” on page 77.

2. Click **Edit**.

3. Complete the Index Attributes dialog box.
   
   For more information, see “Adding an index to a What-If scenario” on page 77.

**Where to go from here**

Explain and compare the statement after you have completed editing.

---

**Related Information**

- “Comparing statements” on page 82
- “Indexes tab” on page 91
- “Explaining SQL statements” on page 72
Generating a tuned statement

After evaluating the effects of What-If indexes on statement performance, you can generate the SQL statements required to create indexes, drop indexes, and update index statistics.

To generate a tuned statement

1. Create a What-If scenario.
   
   For more information, see “Creating and editing a What-If index scenario” on page 75.

2. Make changes as needed to the indexes:
   
   - “Adding an index to a What-If scenario” on page 77
   - “Dropping an index from a What-If scenario” on page 79
   - “Editing an index for a What-if scenario” on page 81
   - “Copying an index for a What-If scenario” on page 80

3. Explain the What-If scenario.
   
   For more information, see “Explaining SQL statements” on page 72.

4. Click Generate.
   
   The Generated Statements pane displays the statement required to make the index changes.

5. Click Save.

6. Save the file to the required data set.
   
   For more information, see “Editing text files in Scratchpad” on page 64.

Comparing statements

Use the following procedure to compare Explain results within the same tuning session.
Before you begin

Create one or more What-If statements, as instructed in “Creating a What-If scenario” on page 73.

Note

The Compare tab is not available until you create at least one What-If scenario.

To compare statements

1. In the Performance perspective, open the Compare tab.

2. From the tuning session pane, in the comparison pane on the left, select the first statement for comparison.

   Note

   The first statement is always displayed in the comparison panel on the left, and the Performance perspective's tabs show information about that statement.

3. From the list in the comparison pane on the right, select a second statement for comparison.

4. Click any step node of the Explain tree to compare the attributes of the selected node.

   The results pane shows detailed information for the selected nodes in the trees.

   Explain trees of both statements are displayed side-by-side, and in the results pane, a table compares attributes of the two statements. In each row, the first column displays the attribute name, the second column displays the value of the node in the first statement (left tree), and the third column shows the value of the second statement (right tree).

   Note

   🌟 indicates that the attribute has different values in the two statements being compared.

Related Information

- “Compare tab” on page 95
Selecting a statement for SQL Analysis

You can perform SQL analysis on an ad hoc statement, a statement selected from a DB2 package, or a statement selected from the DB2 statement cache.

1 Perform one of the following tasks:
   - “Selecting a statement from the DB2 statement cache” on page 84
   - “Selecting a statement from a DB2 package” on page 85
   - “Selecting an ad hoc statement” on page 86

Selecting a statement from the DB2 statement cache

Use the following procedure to select and tune any statement in the DB2 statement cache. You must ensure that the workspace contains a DB2 object view that contains the statement.

To select a statement from the DB2 statement cache

1 Click the DB2 Navigator tab.

2 Click Add DB2 statement cache view.

3 In the DB2 Statement Cache for Program Filter dialog box, select a DB2 subsystem:
   - Type the full or partial name of a DB2 connection to select the first subsystem that matches this value in the list of favorite connections.
   - Use the menu arrow to select from your list of favorite connections.

   **Note**
   Click and specify which DB2 connections to include in your list of favorite connections.

4 In the filter box, enter the name of the program that contains the statement.
   You can use wildcards to return a list of statements contained by programs that match the pattern.
5 Click OK.

In the results pane, a list of statements is displayed.

---

**Note**

Clicking the column headers sorts the results.

---

6 Select the desired statement and click **Explain**.

The Performance perspective displays the graphical Explain for the selected statement in the Explain screen.

---

**Related Information**

- “Selecting a statement for SQL Analysis” on page 84

---

**Selecting a statement from a DB2 package**

Use the following procedure to select a statement from any package.

---

**To select a statement from a package**

1 Click the DB2 Navigator tab.

2 Open or create a package view that contains the required statement.

3 Select the package containing the required statement.

4 From the command toolbar, click **Show Explainable Statements**.

The results pane displays all Explainable statements for that package.

5 Search for and select the required statement.

6 Perform one of the following actions:

- Click **Properties** to view the statement properties.
Click **Explain** ![Explain icon] to display the graphical Explain of the selected statement in the Explain tab. You can now perform SQL tuning tasks.

**Where to go from here**

You can return to the results pane in the DB2 Navigator tab to select other statements.

---

**Related Information**

- “Selecting a statement for SQL Analysis” on page 84

---

**Selecting an ad hoc statement**

Use the following procedure to browse and copy a statement stored in a data set, or to write a statement into the statement box of the Performance perspective.

**Note**

You can set values that are persistent for all ad hoc statements that you create in the current session in the current workspace. For details, see “Setting SQL tuning options” on page 98.

---

**To select an ad hoc statement**

1. Click the Performance perspective.

2. Click **Add SQL Statement View**

3. Complete the SQL tab:
   a. Enter a name for the statement.
   b. Perform one of the following tasks:
   c. Select a DB2 subsystem by using either of the following methods:
      - Type the full or partial name of a DB2 connection to select the first subsystem that matches this value in the list of favorite connections.
      - Use the menu arrow to display and choose from a list of connected subsystems.
Click and specify which DB2 connections to include in your list of favorite connections.

d (optional) Enter the table qualifier.

BMC Workbench for DB2 uses this qualifier if the table in the SQL is unqualified.

e For the Explain Type, select Dynamic.

f At Degree select the degree of parallel processing to allow:
- Select Any to allow parallel processing.
- Select 1 to prohibit parallel processing.

g Type or paste the SQL statement into the SQL statement box.

4 Click Generate explain plan.

The graphical Explain diagram of the SQL statement is displayed.

Related Information
- “Selecting a statement for SQL Analysis” on page 84

Performance perspective

The commands in the Performance perspective enable you to analyze SQL statements, perform What-If comparisons, and migrate access path object statistics.

Selecting a SQL statement for analysis (see “Selecting a statement for SQL Analysis” on page 84), displays the Performance perspective.

The Performance perspective provides access to the result view tabs, which enable you to perform the tuning process. Depending on the activities being performed, the following tabs can be displayed:

- SQL tab
- Indexes tab
- Explain tab
- Cost tab
- Predicates tab
- Compare tab (shown in Figure 2 on page 88)
- Related Objects tab
- Output tab

Figure 2: Performance perspective (Compare tab displayed)

Legend

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tuning session pane</td>
</tr>
<tr>
<td>2</td>
<td>Buttons for adding SQL statement views and removing views</td>
</tr>
<tr>
<td>#</td>
<td>Description</td>
</tr>
<tr>
<td>-----</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>3</td>
<td>Active workspace name</td>
</tr>
<tr>
<td></td>
<td>An asterisk (*) indicates that the workspace has unsaved changes.</td>
</tr>
<tr>
<td>4</td>
<td>Perspective tabs</td>
</tr>
<tr>
<td></td>
<td>The Performance tab is blue, indicating that it is the active tab.</td>
</tr>
<tr>
<td>5</td>
<td><strong>Generate Explain plan</strong> button</td>
</tr>
<tr>
<td></td>
<td>The button is dimmed after the statement is successfully explained.</td>
</tr>
<tr>
<td>6</td>
<td><strong>What-If</strong> button</td>
</tr>
<tr>
<td></td>
<td>The What-If button is disabled (dimmed) on a selected statement if the statement has not been</td>
</tr>
<tr>
<td></td>
<td>successfully explained. Unless the statement is successfully explained, you cannot create a</td>
</tr>
<tr>
<td></td>
<td>What-If scenario based on that statement.</td>
</tr>
<tr>
<td>7</td>
<td><strong>Run</strong> button</td>
</tr>
<tr>
<td>8</td>
<td><strong>Migrate statistics</strong> button</td>
</tr>
<tr>
<td></td>
<td>This button lets you migrate access path statistics for one or more objects.</td>
</tr>
<tr>
<td>9</td>
<td>Name and ID of the active statement</td>
</tr>
<tr>
<td>10</td>
<td><em>(Compare tab only)</em> Explain tree of the first statement</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> 🌟 indicates that at least one attribute of an object has different values in the two</td>
</tr>
<tr>
<td></td>
<td>statements being compared.</td>
</tr>
<tr>
<td>11</td>
<td>The Result view tabs that show the result of explaining a statement, a compare, and cataloged</td>
</tr>
<tr>
<td></td>
<td>objects.</td>
</tr>
<tr>
<td>12</td>
<td><em>(Compare tab only)</em> Explain tree of the second statement</td>
</tr>
<tr>
<td>13</td>
<td>Explain timestamp and DB2 subsystem name</td>
</tr>
<tr>
<td>14</td>
<td><strong>Options</strong> button</td>
</tr>
<tr>
<td>15</td>
<td><em>(Compare tab only)</em> Attribute details of the second statement</td>
</tr>
<tr>
<td>16</td>
<td><em>(Compare tab only)</em> Attribute details of the first statement</td>
</tr>
<tr>
<td>17</td>
<td><em>(Compare tab only)</em> Attribute names</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> 🌟 indicates that the attribute has different values in the two statements being</td>
</tr>
<tr>
<td></td>
<td>compared.</td>
</tr>
</tbody>
</table>
SQL tab

The SQL tab opens when you select a statement for Explain in the Performance perspective, or when you create a tuning session for an ad hoc SQL statement.

If you select a statement from a package or from the statement cache, the statement is displayed in the SQL tab.

Tip
If you want to edit a statement selected from the statement cache or from a package, you must create a What-If scenario.

If you are creating an ad hoc tuning session, you must enter the statement into this pane. You must also populate the dialog box. For more information, see “Selecting an ad hoc statement” on page 86.

Note
After the statement has been explained, click What-If to modify the statement, or enter new parameters to run a subsequent Explain.

Related Information

- “SQL tab” on page 90
- “Indexes tab” on page 91
- “Explain tab” on page 92
- “Cost tab” on page 94
- “Predicates tab” on page 94
- “Related Objects tab” on page 95
- “Output tab” on page 97

Related Information

- “Performance perspective” on page 87
Indexes tab

The Indexes tab lists indexes for all tables participating in the Explain plan. The tab is displayed only after the baseline statement is Explained.

Buttons on the Indexes tab

The following buttons are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Adds an index to a What-If scenario</td>
</tr>
<tr>
<td>Copy</td>
<td>Build a copy of an existing index</td>
</tr>
</tbody>
</table>
| Edit   | Edits the attributes of an index  
  ■ For an existing index, you can only edit the statistics.  
  ■ For an added or copied index, you can edit all fields. |
| Drop   | Drops an index |
| Revert | Reverts changes made for the selected index  
  ■ If the selected index was added, the index is dropped.  
  ■ If the selected index was dropped, the index is reinstated. |
| Generate | Generates statements reflecting changes that you made to a What-If scenario  
This command button is dimmed unless you made changes to the SQL statement. |

**Note**
The command buttons are available only:

■ For What-If scenarios  
   You can upgrade statistics only for existing indexes, but you can copy indexes from existing indexes.

■ For unexplained statements  
   After you have Explained a statement, the command buttons are dimmed.

■ If you have a license for BMC Performance for DB2SQL

Panes

The Indexes tab has a Tables pane and an Indexes pane:

■ The Tables pane lists all tables that are referenced in the SQL statement.
The Indexes pane lists the indexes of the selected table (by default, the table shown at the top of the Tables pane).

**Note**

- ✓ indicates an index that participates in the Explain plan.
- ✗ indicates an index that has been dropped.
- + indicates an index that has been added.
- ✅ indicates an index that has been edited.

**Related Information**

- “Performance perspective” on page 87

---

**Explain tab**

The Explain tab displays a visual representation of the DB2 Explain plan.

You can view the DB2 statement in the format of an Explain diagram (default) or an Explain tree:

- The *Explain diagram* displays each step as a node and indicates the step's cost, type, and message severity level. The following icons indicate the step's type:

  - Operator
  - Query block
  - Table
  - Index

  The node displays one of the following icons to indicate the highest severity of the message rules associated with that step (if a message rule exists):

  - Severe
To focus on specific steps, you can move the nodes around the screen and zoom in and out.

- The *Explain tree* lets you expand or hide steps in order to focus on specific steps.

Graphical Explain enables you to perform the following tasks:

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View step details</strong></td>
<td>1 Perform one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>■ In the Explain diagram, click the linked step name of a node.</td>
</tr>
<tr>
<td></td>
<td>■ In the Explain tree, click the node.</td>
</tr>
<tr>
<td></td>
<td>2 In the Explain Detail property box, select the Step Details tab to</td>
</tr>
<tr>
<td></td>
<td>view the step information from the plan table.</td>
</tr>
<tr>
<td><strong>View message rules</strong></td>
<td>1 Perform one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>■ In the Explain diagram, click the linked step name of a node.</td>
</tr>
<tr>
<td></td>
<td>■ In the Explain tree, click the node.</td>
</tr>
<tr>
<td></td>
<td>2 In the Explain Detail property box, select the message rules tab to</td>
</tr>
<tr>
<td></td>
<td>view the message rules (those delivered by BMC and user-defined message</td>
</tr>
<tr>
<td></td>
<td>rules).</td>
</tr>
<tr>
<td><strong>Toggle between the Explain</strong></td>
<td>Click the Explain Display toggle.</td>
</tr>
<tr>
<td>diagram and Explain tree formats</td>
<td></td>
</tr>
<tr>
<td><strong>Move the node</strong></td>
<td>Click the step node and hold the mouse button while moving the mouse.</td>
</tr>
<tr>
<td><strong>Zoom in and out</strong></td>
<td>Move the Zoom slider, or repeatedly click <strong>Zoom in</strong> or <strong>Zoom out</strong>.</td>
</tr>
<tr>
<td></td>
<td>To change which section of the Explain diagram is displayed, click and</td>
</tr>
<tr>
<td></td>
<td>hold the mouse button while moving the mouse.</td>
</tr>
<tr>
<td><strong>Move a node in the diagram to the</strong></td>
<td>To move a node in a diagram to the top of the screen, double-click the</td>
</tr>
<tr>
<td>top of the screen**</td>
<td>node.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> Clicking <strong>Reset Diagram</strong> reverts to the initial state of the</td>
</tr>
<tr>
<td></td>
<td>graph.</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>Revert the positioning of the Explain diagram to the initial positions</td>
<td>Click <strong>Reset Diagram</strong>.</td>
</tr>
<tr>
<td>Expand or hide steps in the Explain tree</td>
<td>Click the expansion arrow next to the step node.</td>
</tr>
</tbody>
</table>

**Related Information**

- “Performance perspective” on page 87

**Cost tab**

The Cost tab displays the total cost of the Explain plan and other details about the Explain plan.

The results pane is divided into an upper and lower pane:

- The upper pane displays the cost and other details that are extracted from the DB2 plan table.

- The lower pane lists BMC generated message rules and any user-defined message rules.

  The associated icon identifies the rule as Severe ✗, Warning ⚠️, or Informational 🔴.

**Related Information**

- “Performance perspective” on page 87

**Predicates tab**

The Predicates tab displays the filter factors and indexability of each predicate.

The predicates are listed in a table in the order in which they are extracted from the Explain plan tables.
Related Information

- “Performance perspective” on page 87

Compare tab

The Compare tab displays side-by-side Explain trees representing two statements that are being compared.

You can create a What-If scenario and compare it to the source statement or to another What-If scenario. For more information, see “Comparing statements” on page 82.

Note

The Compare tab is available only if the tuning session contains two or more statements.

See “Performance perspective” on page 87 for an example of the Compare tab.

Related Objects tab

The Related Objects tab enables you to view objects related to the tables that are referenced in the statement.

The tab contains two panes:

- The Tables pane lists all of the tables referenced in the SQL statement.

- The other pane contains the Related Objects toolbar and a results table. The results table lists all of the related objects of the selected object type.

You can perform the following tasks:

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a table</td>
<td>On the Tables pane, select the required table. When you change the selected</td>
</tr>
<tr>
<td></td>
<td>table, the results table is updated.</td>
</tr>
</tbody>
</table>
Task | Description
--- | ---
Select a related object | From the Related Objects toolbar, click an object-type button. The results table is populated with all objects of this type that are related to the selected table.

**Note:** You are notified if no related objects of that type exist.

### Table 4: Object-type buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Accelerators" /></td>
<td>Accelerators</td>
</tr>
<tr>
<td><img src="image" alt="Accelerator packages" /></td>
<td>Accelerator packages</td>
</tr>
<tr>
<td><img src="image" alt="Accelerator tables" /></td>
<td>Accelerator tables</td>
</tr>
<tr>
<td><img src="image" alt="Aliases" /></td>
<td>Aliases</td>
</tr>
<tr>
<td><img src="image" alt="Data types" /></td>
<td>Data types</td>
</tr>
<tr>
<td><img src="image" alt="Databases" /></td>
<td>Databases</td>
</tr>
<tr>
<td><img src="image" alt="Data sets" /></td>
<td>Data sets</td>
</tr>
<tr>
<td><img src="image" alt="Key columns" /></td>
<td>Key columns</td>
</tr>
<tr>
<td><img src="image" alt="Image copy" /></td>
<td>Image copy</td>
</tr>
<tr>
<td><img src="image" alt="Indexes" /></td>
<td>Indexes</td>
</tr>
<tr>
<td><img src="image" alt="Packages" /></td>
<td>Packages</td>
</tr>
<tr>
<td><img src="image" alt="Plans" /></td>
<td>Plans</td>
</tr>
<tr>
<td><img src="image" alt="Procedures" /></td>
<td>Procedures</td>
</tr>
<tr>
<td><img src="image" alt="Sequences" /></td>
<td>Sequences</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Storage groups" /></td>
<td>Storage groups</td>
</tr>
<tr>
<td><img src="image2.png" alt="Synonyms" /></td>
<td>Synonyms</td>
</tr>
<tr>
<td><img src="image3.png" alt="Tables" /></td>
<td>Tables</td>
</tr>
<tr>
<td><img src="image4.png" alt="Table columns" /></td>
<td>Table columns</td>
</tr>
<tr>
<td><img src="image5.png" alt="Table constraint" /></td>
<td>Table constraint</td>
</tr>
<tr>
<td><img src="image6.png" alt="Table spaces" /></td>
<td>Table spaces</td>
</tr>
<tr>
<td><img src="image7.png" alt="Table space partitions" /></td>
<td>Table space partitions</td>
</tr>
<tr>
<td><img src="image8.png" alt="Triggers" /></td>
<td>Triggers</td>
</tr>
<tr>
<td><img src="image9.png" alt="Views" /></td>
<td>Views</td>
</tr>
</tbody>
</table>

**Related Information**

- “Performance perspective” on page 87

---

**Output tab**

The Output tab displays the results of an executed SQL statement. The Output tab is displayed when you click **Run** in the Performance perspective.

**Note**

The Run button is dimmed and unavailable when the Output tab is selected.

---

**Related Information**

- “Performance perspective” on page 87
Setting SQL tuning options

You can use the **Options** button to set optional behavior of the SQL tuning feature.

The following tabs are displayed:

- The Tuning tab sets the options for defining SQL tuning settings for the current session.
- The Execution tab sets the options for executing SELECT statements.
- The Statistics Migration tab sets the options for statistics migration. For more details, see “Setting statistic migration options” on page 107.

**Tuning tab**

The Tuning tab lets you set the following types of options: dynamic SQL, ad hoc SQL, and general.

**Table 5: Dynamic SQL options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan Table Owner</td>
<td>Specifies the name of the owner for the DB2 plan table used</td>
<td>BMC</td>
</tr>
<tr>
<td>Note:</td>
<td>If you want the owner to use lowercase characters, verify that you have not enabled Convert filter values to upper case. See “Setting BMC Workbench options” on page 31.</td>
<td></td>
</tr>
</tbody>
</table>

**Table 6: Ad Hoc SQL options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Qualifier</td>
<td>Specifies a table qualifier to qualify DB2 objects that are not qualified in the SQL statement</td>
<td>No default value</td>
</tr>
<tr>
<td>Degree</td>
<td>Specifies whether to consider parallel processing during an Explain:</td>
<td>Default = Any</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Any</strong> considers parallel processing.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ 1 does not consider parallel processing.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Blank uses the value at bind time.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 7: General options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule set</td>
<td>Defines the message rules:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ DEFAULT displays all rules that are related to performance issues and are</td>
<td>DEFAULT</td>
</tr>
<tr>
<td></td>
<td>primarily relevant to DBAs.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ APPDEV displays rules that are primarily relevant to application developers.</td>
<td></td>
</tr>
<tr>
<td>Online Application</td>
<td>Specifies whether to trigger specific rules for table space scan, list and</td>
<td>Unchecked</td>
</tr>
<tr>
<td></td>
<td>sequential prefetch, and multiple index access paths (MIAP) considerations:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Select to trigger the rules</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Clear to not trigger the rules</td>
<td></td>
</tr>
<tr>
<td>Cost Translation</td>
<td>Specifies the rate used to translate the timeron cost into a monetary unit</td>
<td>1.0</td>
</tr>
<tr>
<td>Rate per Timeron</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cost Translation</td>
<td>Specifies the rate used to translate the service unit cost into a monetary</td>
<td>1.0</td>
</tr>
<tr>
<td>Rate per Service</td>
<td>unit</td>
<td></td>
</tr>
<tr>
<td>Unit</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Execution tab**

The Execution tab lets you set the select options.

### Table 8: Select options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Options</td>
<td>For SELECT statements, this option lets you set maximum values for the following items (with defaults shown in parentheses):</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>■ Maximum numeric length (10)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Maximum CHAR length (64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Maximum VARCHAR length (64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Maximum select rows (300), where 0 returns all rows in the result set.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The total amount of returned data in the result set cannot exceed 50 MB; the Select Options settings do not affect that limit. If the limit is reached, the product alerts you with a message.</td>
<td></td>
</tr>
</tbody>
</table>
Related Information

- “Selecting an ad hoc statement” on page 86
Migrating statistics

BMC Workbench enables you to migrate the access path statistics for a set of objects from one subsystem to another, or from one schema to another within the same subsystem.

For the selected objects, BMC Workbench migrates the table, table space, and index statistics that affect the access-path.

For example, you can migrate production statistics to a test environment to view the actual access paths that the DB2 optimizer selects, without the cost of replicating the production environment.

You can select objects from a Results list in the DB2 Navigator perspective, or select objects included in a SQL Tuning session in the Performance perspective.

You can reuse a saved Migrate Statistics session. In the reused session, you can update objects with current access-path statistics, or change the source or target of the statistics.

You can use the Options button to set optional behaviors of the statistics migration feature.

For more information, view the Quick Course "Workbench for DB2 - Migrating Statistics."

Migrating access-path statistics from the DB2 Navigator

To update objects with migrated access-path statistics, use the following procedure to select objects for statistics migration from the DB2 Navigator.

To migrate access-path statistics from the DB2 Navigator

1. Click the DB2 Navigator perspective.
2 Open or create an object view.

3 Select one or multiple objects from the database, table space, table, or index list.

**Note**
The table, table space, and index statistics that affect the access path are migrated for the selected objects.

4 Click **Migrate Statistics** , and then click either **Migrate Statistics From** or **Migrate Statistics To**:

- Select **Migrate Statistics From** to migrate statistics from the objects selected from the Results list. The object or objects that you want to update must already exist on the target subsystem.
- Select **Migrate Statistics To** to migrate statistics to the objects selected from the Results list.

**Tip**
Alternatively, you can right-click the selected objects and select **Tasks => Migrate Statistics => Migrate Statistics From** or **Migrate Statistics To**.

5 Complete the following fields of the Parameters of the Migrate Statistics panel, and then click **Next**:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the Migrate Statistics session.</td>
</tr>
<tr>
<td>Include Table Statistics</td>
<td>Select this box to migrate the table statistics for the selected object. This box is initially selected by default.</td>
</tr>
<tr>
<td>Include Index Statistics</td>
<td>Select this box to migrate the statistics of all indexes for the selected object. This box is initially selected by default.</td>
</tr>
<tr>
<td>DB2 Connections</td>
<td>Select the DB2 subsystem from the list of subsystems that are connected to the source DB2 subsystem.</td>
</tr>
<tr>
<td></td>
<td>If you selected <strong>Migrate Statistics From</strong>, you are selecting the target DB2 subsystem.</td>
</tr>
<tr>
<td></td>
<td>If you selected <strong>Migrate Statistics To</strong>, you are selecting the source DB2 subsystem.</td>
</tr>
<tr>
<td>Translation</td>
<td>Define relevant translation rules for source objects that you are migrating, so that they match the target objects. You can replace all occurrences of a specified string with another specified string.</td>
</tr>
<tr>
<td></td>
<td>Do not use wildcard characters (including % or *).</td>
</tr>
</tbody>
</table>
Clicking **Next** displays the Object List of the Migrate Statistics panel, which lists the tables, table spaces, and indexes to be migrated. The panel also indicates the source and target direction of the migration and displays a status icon beside each object. The status icon indicates all valid objects with ✔️, and invalid objects with ⚠️.

6 For each invalid object, take one of the following actions:

- Click **Back**, and update the translation rules. Then click **Next**.

- Select and update the invalid name. Then click Verify ✔️ or Verify all ✔️.

7 Clear any objects that you do not want to migrate.

**Tip**

Toggle ✔️ to select or clear all objects.

You can use the filter buttons to view specific object types, or to view only the valid or invalid objects.

8 *(optional)* Click **Next** to view the Summary.

9 To start the migration, click **Finish**.

The results are displayed in a results table in the Results tab in the Performance perspective:

- ✔️ identifies objects that migrated successfully.

- ⚠️ identifies objects that failed to migrate, and a message explains the failure. You can hover over the message to view details.

The Migrate Statistics session is listed under **Stats Migration** in the Navigation pane in the Performance perspective.

10 For any objects that failed to migrate, complete this step:

a  Hover the cursor over the explanatory message to see details.

b  Click the Parameters tab.

c  Make the required changes to the Translation parameters.

d  When the following message is displayed at the bottom of the panel, click to refresh the objects list.
Statistics migration updates the following DB2 statistics tables:

- SYSTABLESPACE
- SYSTABLES
- SYSCOLUMNS
- SYSCOLSTATS
- SYSCOLDIST
- SYSTABSTATS
- SYSINDEXES
- SYSKEYTARGETS
- SYSKEYTARGETSTATS
- SYSKEYTGTDIST
- SYSKEYTGTDISTSTATS

**Related Information**

- “Migrating access-path statistics from a SQL Tuning session” on page 104
- “Setting statistic migration options” on page 107

---

**Migrating access-path statistics from a SQL Tuning session**

To update objects with migrated access-path statistics, use the following procedure to select objects for statistics migration from a SQL Tuning session.

**To migrate access-path statistics from a SQL Tuning session**

1. Select the Performance perspective.

2. From a tuning session, either select a statement that has been explained or perform Explain on the statement.

   See “Explaining SQL statements” on page 72.
3 Click Migrate Statistics, and then click either Migrate Statistics From or Migrate Statistics To:

- Select Migrate Statistics From to migrate statistics from the objects included in the SQL Tuning session. The object or objects that you want to update must already exist on the target subsystem.

- Select Migrate Statistics To to migrate statistics to the objects included in the SQL Tuning session.

4 Complete the following fields of the Parameters of the Migrate Statistics panel, and then click Next:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the Migrate Statistics session.</td>
</tr>
<tr>
<td>Include Table Statistics</td>
<td>Select this box to migrate the table statistics for the selected object.</td>
</tr>
<tr>
<td></td>
<td>This box is initially selected by default.</td>
</tr>
<tr>
<td>Include Index Statistics</td>
<td>Select this box to migrate the statistics of all indexes for the selected object.</td>
</tr>
<tr>
<td></td>
<td>This box is initially selected by default.</td>
</tr>
<tr>
<td>DB2 Connections</td>
<td>Select the DB2 subsystem from the list of subsystems that are connected to the source DB2 subsystem.</td>
</tr>
<tr>
<td></td>
<td>If you selected Migrate Statistics From, you are selecting the target DB2 subsystem.</td>
</tr>
<tr>
<td></td>
<td>If you selected Migrate Statistics To, you are selecting the source DB2 subsystem.</td>
</tr>
<tr>
<td>Translation</td>
<td>Define relevant translation rules for source objects that you are migrating, so that they match the target objects. You can replace all occurrences of a specified string with another specified string.</td>
</tr>
<tr>
<td></td>
<td>Do not use wildcard characters (including % or *).</td>
</tr>
</tbody>
</table>

Clicking Next displays the Object List of the Migrate Statistics panel, which lists the tables, table spaces, and indexes to be migrated. The panel also indicates the source and target direction of the migration and displays a status icon beside each object. The status icon indicates all valid objects with ✓, and invalid objects with ▼.

5 For each invalid object, take one of the following actions:

- Click Back, and update the translation rules. Then click Next.

- Select and update the invalid name. Then click Verify ✓ or Verify all ▼.
6 Clear any objects that you do not want to migrate.

*Tip*
Toggle to select or clear all the objects. You can use the filter buttons to view specific object types, or to view only the valid or invalid objects.

7 *(optional)* Click **Next** to view the Summary.

8 To start the migration, click **Finish**.

The results are displayed in a results table in the Results tab in the Performance perspective:

- ✔ identifies objects that migrated successfully.
- ! identifies objects that failed to migrate, and a message explains the failure. You can hover over the message to view details.

The Migrate Statistics session is listed under **Stats Migration** in the Navigation pane in the Performance perspective.

9 For any objects that failed to migrate, complete this step:

a Hover the cursor over the explanatory message to see details.

b Click the Parameters tab.

c Make the required changes to the Translation parameters.

d When the following message is displayed at the bottom of the panel, click to refresh the objects list.

   Input parameters have been updated. The object list is stale.

e On the toolbar, click to repeat the migration.

A new Results tab is displayed, which displays updated results.

Statistics migration updates the following DB2 statistics tables:

SYSTABLESPACE
SYSTABLES
Setting statistic migration options

Use the following procedure to set options for migrating access-path statistics. You can set these options from the Performance perspective, the DB2 Navigation perspective, or the Migrate Statistics panel.

1. Select the Options button.

2. On the Statistics Migration tab, set the following options and click OK:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timestamp to use for STATSTIME</td>
<td>Specifies the timestamp used to update STATSTIME on the target object: ■ Select Current to use the machine time. ■ Select Source to use the source object timestamp.</td>
</tr>
<tr>
<td>Continue on SQL Error</td>
<td>Tells BMC Workbench what to do if the migration process encounters an object containing a SQL error: ■ Selecting this option tells BMC Workbench to continue the migration. ■ Clearing this option tells BMC Workbench to exit the migration.</td>
</tr>
<tr>
<td>Delete statistics before migration</td>
<td>Specifies whether to delete all previous instances of the target table spaces' SYSCOLDIST, SYSTABSTATS, SYSKEYTGTDIST, and SYSKEYTGTDISTSTATS tables before inserting the migrated statistics row or rows</td>
</tr>
</tbody>
</table>
Related Information

- “Migrating access-path statistics from the DB2 Navigator” on page 101
- “Migrating access-path statistics from a SQL Tuning session” on page 104
Displaying BMC utilities

You can view a list of all BMC Utilities that are running on a specified IBM DB2 subsystem. From this list, you can drill down and view the objects that each utility is accessing.

Creating a Utility Status view

Use the following procedure to create a new Utility Status view.

1. Open or create a workspace.

2. In the DB2 Navigator perspective, click the Add View menu arrow, and then click Add Utility Status View.

   Tip
   You can also right-click in the DB2 navigation pane to select this action. The default value of the Add View menu is always the last option that you created. For example, if the last view you created was a new DB2 Statement Cache view, then clicking creates a new DB2 Statement Cache view.

3. In the Add Utility Status View dialog box, complete the following fields or accept the displayed default values:
<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 Connection</td>
<td>Use either of the following methods:</td>
</tr>
<tr>
<td></td>
<td>- Type the full or partial name of a DB2 connection to select the first subsystem that matches this value in the list of favorite connections.</td>
</tr>
<tr>
<td></td>
<td>- Use the menu arrow to select from your list of favorite connections.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> You can add DB2 connections to your list of favorite connections by clicking <img src="image" alt="Add Connection" /> and specifying which connections to include.</td>
</tr>
<tr>
<td>Filter</td>
<td>Enter a filter pattern for the Utility ID.</td>
</tr>
</tbody>
</table>

4. Click **OK**.

The navigation pane lists the matching utilities and displays the following information about each one:

- Utility ID
- User ID
- Utility name
- Status
- Phase
- Restart
- Database
- Space name
- Space status
- Start timestamp
- Command
- NOTEID

5. *(optional)* Select a utility and click **Utility Status Detail ICON**.

The Utility Status Detail screen shows the objects that the utility accesses and includes the following information about each object:

- Fully qualified object name
- Partition
- Blocks
- BMCID
- DDNAME
- EXTRABA
- KIND
- ORIG_STATUS
- SHRLEVEL
- XCOUNT

6 When finished, save the workspace.
Creating a Utility Status view
Comparing DB2 schemas

If you have a license for the BMC Object Administration for DB2 solution, you can use BMC Workbench to compare two sets of data structures. The objects can reside in a DB2 catalog or a DDL file.

The comparison process enables you to perform the following tasks:

- Record changes made to a local or remote subsystem
- Understand structure changes between two subsystems to help you determine which changes to migrate

For more information, view the Quick Course "Workbench for DB2 - Comparing DB2 Schemas."

Comparing two schemas

Comparing schemas involves generating and viewing a set of reports. The reports list the objects that need to be created, altered, or dropped to make the two structures identical. BMC Workbench generates the Change Definition Language (CDL) that defines the changes that must be applied to make the schema's structures identical. You can save the CDL to a dataset and edit the CDL in the Scratchpad editor.

BMC Workbench enables you to make the following comparisons:

- DB2 catalog to DB2 catalog
- DDL to DDL
- DB2 catalog to DDL
- DDL to DB2 catalog
BMC Workbench can generate DDL statements containing lines that are longer than 72 characters. These DDL statements cannot be used in a schema comparison.

The same set of reports is available for each type of comparison. For more information, see “Schema-comparison reports” on page 117.

Use the following procedure to create and display a Schema Compare View for each comparison that you want to see. You can also navigate to and run a saved schema comparison.

**To create a Schema Compare View**

The comparison requires two inputs:

- The schema or set of DB2 objects that has the structure definitions that you want to change (called the Primary Input in the procedure)
- The schema that has the preferred structure definitions, to serve as the basis for changing the other schema (called the Secondary Input)

**Note**

After you have specified the two data structures for comparison, you can click Finish, without changing the default dependent objects, attributes, and options values.

1. In the Schema Management perspective, click Add Schema Compare View.

   The Define a Comparison wizard opens.

2. On the wizard's Step 1-General page, complete the following fields and click Next:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the report.</td>
</tr>
<tr>
<td>Select a report</td>
<td>Select to create a new report or use an existing report.</td>
</tr>
</tbody>
</table>

3. On the wizard's Step 2 page, take the appropriate action as follows:

   - *If you are using an existing report, complete these actions:*

     1. On the wizard's Step 2 - Comparison Dataset page, navigate to and select the data set that contains the report and click Next.

        For more information, see “Viewing and editing a data set” on page 147.
2 *(optional)* In the wizard’s **Step 3 - Options** page, select **Enable Trace** to provide informational messages in the View Messages dialog.

3 Click **Finish**.

4 Click ![Restart button](image) to rerun the report.

*If creating a new report*, on the wizard’s **Step 2-Type of Comparison** page, complete the following fields and click **Next**:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare Type</td>
<td>Select the type of comparison that you require.</td>
</tr>
<tr>
<td>Output Compare Report</td>
<td>Navigate to and select a data set to save the output of the comparison.</td>
</tr>
</tbody>
</table>

4 On the wizard’s **Step 3 - Data Structures** page, complete the following fields according to the type of comparison that you are performing:

**Table 9: Catalog to catalog**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 objects that do not have the desired structure (primary input)</td>
<td></td>
</tr>
<tr>
<td>Object Type</td>
<td>Select the object type.</td>
</tr>
<tr>
<td>DB2 Connection</td>
<td>Select the DB2 connection from your list of favorites or add a DB2 connection to the list. (For more information, see “Connecting to DB2 subsystems” on page 25.)</td>
</tr>
<tr>
<td>Filter</td>
<td>Specify a filter for the name of the DB2 objects that you want to compare.</td>
</tr>
<tr>
<td>DB2 objects that have the desired structure (secondary input)</td>
<td></td>
</tr>
<tr>
<td>DB2 Connection</td>
<td>Select the DB2 connection from the list.</td>
</tr>
<tr>
<td>Filter</td>
<td>Specify a filter for the name of the DB2 objects that you want to compare.</td>
</tr>
</tbody>
</table>

**Table 10: DDL to DDL**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 objects that do not have the desired structure (primary input)</td>
<td></td>
</tr>
<tr>
<td>DB2 Connection</td>
<td>Select the DB2 connection from your list of favorites or add a DB2 connection to the list, as explained in “Connecting to DB2 subsystems” on page 25.)</td>
</tr>
<tr>
<td>DDL Data Set</td>
<td>Select the DDL data set. This data set defines the scope of the comparison. For more information, see “Viewing and editing a data set” on page 147.</td>
</tr>
<tr>
<td>DB2 objects that have the desired structure (secondary input)</td>
<td></td>
</tr>
</tbody>
</table>
Comparing two schemas

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DDL Data Set</td>
<td>Select the DDL data set. For more information, see “Viewing and editing a data set” on page 147.</td>
</tr>
</tbody>
</table>

Table 11: Catalog to DDL

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 objects that do not have the desired structure (primary input)</td>
<td></td>
</tr>
<tr>
<td>DB2 Connection</td>
<td>Select the DB2 connection where the schema is stored.</td>
</tr>
<tr>
<td>DB2 objects that have the desired structure (secondary input)</td>
<td></td>
</tr>
<tr>
<td>DDL Data Set</td>
<td>Select the DDL data set. This data set defines the scope of the comparison. For more information, see “Viewing and editing a data set” on page 147.</td>
</tr>
</tbody>
</table>

Table 12: DDL to Catalog

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 objects that do not have the desired structure (primary input)</td>
<td></td>
</tr>
<tr>
<td>DDL Data set</td>
<td>Select the DDL data set This data set defines the scope of the comparison. For more information, see “Viewing and editing a data set” on page 147.</td>
</tr>
<tr>
<td>DB2 objects that have the desired structure (secondary input)</td>
<td></td>
</tr>
<tr>
<td>DB2 Connection</td>
<td>Select the DB2 connection where the schema is stored.</td>
</tr>
</tbody>
</table>

5 Click Next.

6 On the wizard’s Step 4 - Dependent objects page, select the dependent objects to include in the comparison and click Next.

Note

To compare a DB2 catalog to a DB2 catalog, the Resolve object or creator name differences checkbox is enabled by default. When this option is enabled, the product excludes databases, table spaces, synonyms, and aliases from the comparison because duplicates might occur. The product performs this name conversion to resolve the differences in the object owners, schemas, and database names.

7 On the wizard’s Step 5 - Attributes page, select the attributes for each object type to include in the comparison and click Next.
8 On the wizard’s **Step 6 - Options** page, specify the option values for the current definition.

These values do not affect the global compare options that you specify by using the Options button 🔄.

9 Click **Finish**.

The Reports tab displays the reports for this comparison. For more information, see “Schema-comparison reports” on page 117.

10 *(optional)* If you want to view the generated CDL for the comparison, click **Show CDL** to view the CDL in the Scratchpad.

---

**Note**

You cannot run the CDL from the Scratchpad.

11 *(optional)* If you want to rerun the comparison, click **Run**.

**To copy a Schema Compare View**

You can also copy all the definitions (name, type and output, data structures, dependent objects, attributes, and options) of an existing Schema Compare View.

1 In the Navigation pane, right-click a Schema Compare View.

2 Click **Copy Definition**.

A copy of the selected Schema Compare View is created.

3 Edit the Schema Compare View.

4 Save the Workspace.

**Schema-comparison reports**

When you run a schema comparison, you can generate and view reports that display the required changes to match the schemas by statement type or by object type, or show the detailed CDL for each action.
Overview by Statement Type report

The report displays the number of each CDL statement (ALTER, DROP, and CREATE) required to match the two schemas. The report also displays a breakdown of the objects that each statement affects.

Figure 3: Sample Overview by Statement Type report

Table 13: Legend—Overview by Statement Type report

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Show Compare Report</td>
<td>Updates the compare reports</td>
</tr>
<tr>
<td>#</td>
<td>Description</td>
<td>Details</td>
</tr>
<tr>
<td>----</td>
<td>--------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2</td>
<td><strong>Show CDL button</strong></td>
<td>Displays the CDL statements in the Scratchpad</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot run the CDL from the Scratchpad.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Reports tab</td>
<td>Displays the reports</td>
</tr>
<tr>
<td>4</td>
<td>Report description</td>
<td>Describes what the pie chart is showing</td>
</tr>
<tr>
<td></td>
<td><strong>For example,</strong> the description in the figure indicates that the pie chart shows results for the CREATE action.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Pie chart section</td>
<td>Shows the objects breakdown for the selected statement (ALTER, CREATE, DROP) in the column chart</td>
</tr>
<tr>
<td>6</td>
<td>Report selector</td>
<td>Enables you to select the following reports:</td>
</tr>
<tr>
<td></td>
<td><strong>- Overview by Statement Type</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>- Overview by Object Type</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>- Details</strong></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td><strong>Schema Management options</strong> button</td>
<td>Displays the Schema Management options</td>
</tr>
<tr>
<td></td>
<td><strong>See “Setting Schema Management options” on page 124.</strong></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Help button</td>
<td>Displays the online Help</td>
</tr>
<tr>
<td>9</td>
<td><strong>Show object color legend button</strong></td>
<td>Shows or hides the object-color legend</td>
</tr>
<tr>
<td>10</td>
<td>Object color legend</td>
<td>Indicates the color that corresponds to each object type in the pie chart</td>
</tr>
<tr>
<td>11</td>
<td>CDL statement detail pane</td>
<td>Shows the detailed CDL statement required to perform the action for the selected object (in this example, a CREATE statement for the table space)</td>
</tr>
<tr>
<td>12</td>
<td>List of CDL statements</td>
<td>Lists the CDL statements (in this example, a list of the CREATE TABLESPACE statements). The detailed CDL for the selected statement is displayed.</td>
</tr>
<tr>
<td>13</td>
<td>Column chart showing the count of CREATE, ALTER, and DROP statements required to make the first structure identical to the second structure</td>
<td>When you click on a column, displays the object type breakdown When you double-click on a column, displays a list of all the CDL statements for the selected column</td>
</tr>
</tbody>
</table>

This report is interactive. You can change the information displayed by clicking or hovering over report elements.

You can navigate through the report as follows:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>List statements for a statement type</td>
<td>Double-click the relevant statement column in the column chart.</td>
</tr>
<tr>
<td>List statements for the selected object type and statement type</td>
<td>Double-click the relevant section of the pie chart.</td>
</tr>
</tbody>
</table>
To | Do this
---|---
Update the object breakdown in the pie chart | Click the relevant statement column in the column chart.
Update a list of statements for the selected object type and statement type | Click the relevant section of the pie chart.
View the count information | Hover over the relevant column of the column chart or relevant segment of the pie chart.

**Example**

This example lets you view the number of dropped table spaces:

1. In the Summary by Statement Type column chart, double-click the column representing the DROP action.

2. In the Object Type Breakdown pie chart, hover over the segment representing table spaces, then double-click the segment representing table spaces. A list of DROP TABLESPACE statements is displayed.

**Example**

This example lets you View a CREATE INDEX statement for a specific index:

1. In the Summary by Statement Type column chart, click the column representing the CREATE action.

2. In the Object Type Breakdown pie chart, double-click the segment representing Indexes. A list of CREATE INDEX statements is displayed.

3. In the CREATE INDEX Statements panel (left pane), select the CREATE INDEX statement for the specific index. The detailed CDL statement is displayed in the right pane.

**Related Information**

- “Setting Schema Management options” on page 124
- “Overview by Object Type report” on page 121
- “Details report” on page 123
Overview by Object Type report

This report displays the number of DROP, CREATE, and ALTER statements required for each object type. You can select and view a specific CDL statement for an object.

Figure 4: Sample Overview by Object Type report

Table 14: Legend —Overview by Object Type report

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Show Compare Report button</td>
<td>Updates the compare reports</td>
</tr>
<tr>
<td>2</td>
<td>Show CDL button</td>
<td>Displays the CDL statements in the Scratchpad Note: You cannot run the CDL from the Scratchpad.</td>
</tr>
<tr>
<td>3</td>
<td>Details for each object type</td>
<td>For each object type, displays the number of DROP, CREATE, and ALTER CDL statements and the number of fetches</td>
</tr>
<tr>
<td>#</td>
<td>Description</td>
<td>Details</td>
</tr>
<tr>
<td>----</td>
<td>------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>4</td>
<td>CDL statements pane</td>
<td>Lets you select a statement in order to view its details in the pane on the right</td>
</tr>
<tr>
<td>5</td>
<td>CDL details pane</td>
<td>Displays the details of the selected CDL statement</td>
</tr>
</tbody>
</table>
| 6  | **Schema Management options** button | Displays the Schema Management options  
See “Setting Schema Management options” on page 124.                                         |
| 7  | **Help** button                    | Displays the online Help                                                                    |

**Related Information**

- “Setting Schema Management options” on page 124
- “Overview by Statement Type report” on page 118
- “Details report” on page 123
Details report

This report displays a filterable list of all actions needed in order to make the two schemas match. You can filter the list by objects or by actions. You can select an action or object, and view the CDL statements.

Figure 5: Details report

Table 15: Legend

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CDL statement pane</td>
<td>Lets you select a statement in order to view its details in the pane on the right</td>
</tr>
<tr>
<td>2</td>
<td>Object filters</td>
<td>By default, displays all objects (with object filters shown in green) Click a filter to hide the associated object.</td>
</tr>
<tr>
<td>3</td>
<td>All objects filter button</td>
<td>Displays all objects Click to select or deselect all filters.</td>
</tr>
<tr>
<td>4</td>
<td>CDL details pane</td>
<td>Displays the details of the selected CDL statement</td>
</tr>
<tr>
<td>5</td>
<td>Action filters</td>
<td>Hides the associated action</td>
</tr>
</tbody>
</table>
Setting Schema Management options

You can use the Options button 🛠️ to set optional behavior for the Schema Management feature. These settings also serve as the default option settings for all new Schema Compare views.

**Note**

You can override the options settings for a specific Schema Compare View in the Define a Comparison wizard. For more information, see “Comparing two schemas” on page 113.

The following options can be specified:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use European format for decimal numbers (EURO)</td>
<td>Select whether to use the European decimal format (1,234,567,89). This value corresponds to the CHANGE MANAGER EURO installation option.</td>
<td>No</td>
</tr>
<tr>
<td>Use padded values for columns of type VARCHAR (Padded)</td>
<td>Select whether to pad VARCHAR values. This option corresponds to the CHANGE MANAGER OVERRIDE(IXPADDEN) and OVERRIDE(IXPADDEN) ALUIN keywords, and to the PADIX DSNZPARM.</td>
<td>No</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Default value</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Include the primary key constraint in the scope</td>
<td>Select whether to include the primary key constraint in the scope. This option corresponds to the CHANGE MANAGER OVERRIDE(KEEP-ALL-PRIMARY) ALUIN keyword.</td>
<td>No</td>
</tr>
<tr>
<td>Include white spaces in native SQL stored procedure comparisons</td>
<td>Select whether to include white spaces in native SQL stored procedures. This option corresponds to the CHANGE MANAGER CMPSPTXT installation option, and the SPTEXT( EXACT ) or SPTEXT( NOEXACT ) ALUIN keyword.</td>
<td>Yes</td>
</tr>
<tr>
<td>CCSID</td>
<td>Select the default encoding scheme for databases that are created. This option corresponds to the CHANGE MANAGER CCSID installation option.</td>
<td>EBCDIC</td>
</tr>
<tr>
<td>CISIZE</td>
<td>Select N to create VSAM data sets with a control interval size (CISIZE) of 4 KB, regardless of the page size (buffer pool size) of the table space. Select Y to support larger CISIZE values. This option corresponds to the DSVCI DSNZPARM.</td>
<td>Blank</td>
</tr>
<tr>
<td>Length of inline LOB columns</td>
<td>Enter a value for the inline LOB column. This option corresponds to the LOB_INLINE_LENGTH DSNZPARM.</td>
<td>0</td>
</tr>
<tr>
<td>OVERRIDE</td>
<td>Enter one or more space-separated CHANGE MANAGER OVERRIDE keywords (maximum of 57 characters). <strong>Note:</strong> Do not enclose the OVERRIDE keywords between parentheses. For more information, see “OVERRIDE keywords” on page 125.</td>
<td>NA</td>
</tr>
<tr>
<td>Enable Trace</td>
<td>Select whether to include informational messages. Consult with BMC Customer Support before using this option.</td>
<td>No</td>
</tr>
</tbody>
</table>

**OVERRIDE keywords**

You can use OVERRIDE keywords in the OVERRIDE field to override the comparison default values.

You can enter a list of space-separated keywords, containing a maximum of 57 characters, into the field.
**Note**  
Do not enclose the OVERRIDE keywords between parentheses.

### Table 16: OVERRIDE keywords

<table>
<thead>
<tr>
<th><strong>Keyword</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>CKSEGSIZE</td>
<td>Shows the differences between a simple table space and a segmented table space defined with a SEGSIZE of 4</td>
</tr>
</tbody>
</table>
| ENQFAILRC4       | Produces a return code of 4 when the deletion of a baseline fails because the baseline is in use  
This keyword overrides the default return code of 0.  
You must manually insert this keyword in the ALUIN input stream. |
| FKNN             | Shows the differences between two foreign keys when one has a three-part explicit name and the other has no name (and part three is not specified) |
| GENOBID          | Specifies the value of the OBID as a comment for a CREATE TABLE statement in the CDL  
This comment is used when you compare a file or DB2 catalog to either a catalog baseline or a DB2 catalog. The comment also appears in the baseline report. |
| INCLUDEPARENTS   | Includes the parent objects of tables or table spaces in the scope of a catalog-to-catalog comparison.  
This keyword applies when you are specifying the object types and object names for primary input and secondary input to explicitly define the scope of the comparison. |
<p>| IXPADDEDN        | Uses the default of PADDED NO for an index, regardless of the value in the DB2 subsystem parameter DSNZPARM                                        |
| IXPADDEDSN        | Uses the default of PADDED YES for an index, regardless of the value in the DB2 subsystem parameter DSNZPARM                                          |
| KEEP-ALL-PRIMARY | Includes the primary key constraint in a baseline or comparison when you exclude unique constraints                                                 |
| LONGVARCOLS      | Shows the differences between two columns when one column has a LONG VARCHAR data type and the other column has a VARCHAR data type                  |
| NO-PRIMARY-CONSTRAINTS | Ignores the primary key constraint in a baseline or comparison when you exclude unique constraints                                        |
| NOAPPEND         | Ignores the APPEND attribute of a table in a comparison                                                                                     |
| NOCLONES         | Ignores clone tables in a comparison                                                                                                         |
| NODSSIZE         | Ignores the DSSIZE attribute of a table space in a comparison                                                                                  |
| NOENFORCED       | Ignores the ENFORCED attribute of a foreign key in a table in a comparison                                                                      |</p>
<table>
<thead>
<tr>
<th><strong>Keyword</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>NOGBPCACHE</td>
<td>Ignores the GBPCACHE attribute of table spaces in a comparison</td>
</tr>
<tr>
<td>NOINLINELOB</td>
<td>Ignores the INLINE attribute of table spaces in a comparison</td>
</tr>
<tr>
<td>NOIXCLOSE</td>
<td>Ignores the CLOSE attribute of an index in comparison</td>
</tr>
<tr>
<td>NOIXCOMPRESS</td>
<td>Ignores the COMPRESS attribute of an index in a comparison</td>
</tr>
<tr>
<td>NOIXCOPY</td>
<td>Ignores the COPY attribute of an index in a comparison</td>
</tr>
<tr>
<td>NOIXPADDDED</td>
<td>Ignores the PADDDED attribute of an index in a comparison</td>
</tr>
<tr>
<td>NOLIMITKEYS</td>
<td>Ignores the LIMITKEY attribute of a partitioned table space in a comparison</td>
</tr>
<tr>
<td>NOLOG</td>
<td>Ignores the LOG attribute of a table space in a comparison</td>
</tr>
<tr>
<td>NOPIECESIZE</td>
<td>Ignores the PIECESIZE attribute of an index in a comparison</td>
</tr>
<tr>
<td>NOSPACTIVE</td>
<td>Ignores the active version attribute for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPASUTIME</td>
<td>Ignores the ASUTIME option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPCCSID</td>
<td>Ignores the CCSID option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPCCOLLID</td>
<td>Ignores the package collection ID option for stored procedures in a comparison.</td>
</tr>
<tr>
<td>NOSPCOMMEDITRETURN</td>
<td>Ignores the commit on return option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPCONACCRESO</td>
<td>Ignores the concurrent access resolution option for stored procedures in a comparison.</td>
</tr>
<tr>
<td>NOSPCURRENTDATA</td>
<td>Ignores the CURRENTDATA option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPDATAACC</td>
<td>Ignores the SQL DATA ACCESS option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPDATEFORMAT</td>
<td>Ignores the date format option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPDBINFO</td>
<td>Ignores the DBINFO option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPDEBUGMODE</td>
<td>Ignores the DEBUG MODE option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPDECIMAL</td>
<td>Ignores the DECIMAL option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPDEFERPREPARE</td>
<td>Ignores the DEFER PREPARE option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPDEGREE</td>
<td>Ignores the degree option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPDETERMINISTIC</td>
<td>Ignores the deterministic option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPDYNRULES</td>
<td>Ignores the dynamic rules option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPEXPLAIN</td>
<td>Ignores the EXPLAIN option for stored procedures in a comparison</td>
</tr>
<tr>
<td>Keyword</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>NOSPEXTNAME</td>
<td>Ignores the external name option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPFORUPD</td>
<td>Ignores the FOR UPDATE clause option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPIMMEDWRITE</td>
<td>Ignores the IMMEDIATE WRITE option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPISOLEVEL</td>
<td>Ignores the isolation level option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPJAVA</td>
<td>Ignores the JAR SCHEMA, JAR ID, and JAVA SIGNATURE options for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPKEEPDYN</td>
<td>Ignores the KEEP DYNAMIC option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPLANGUAGE</td>
<td>Ignores the implementation language option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPMAXFAIL</td>
<td>Ignores the maximum number of failures option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPOTHINT</td>
<td>Ignores the OPTHINT option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPPACKOWNER</td>
<td>Ignores the package owner option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPPARAMETERS</td>
<td>Ignores the parameter attributes for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPPARMCCSID</td>
<td>Ignores the PARAMETER CCSID option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPPARMDATATYPE</td>
<td>Ignores the data type of the parameter for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPPARMFORBIT</td>
<td>Ignores the subtype of the parameter for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPPARMINOUT</td>
<td>Ignores the row type of the parameter for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPPARMLOC</td>
<td>Ignores the location of the parameter for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPPARMNAME</td>
<td>Ignores the name of the parameter for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPPARMORDER</td>
<td>Ignores the ordinal number of the parameter for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPPARMSTYLE</td>
<td>Ignores the PARAMETER STYLE option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPPARMVCHAR</td>
<td>Ignores the varying length string parameter for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPPROGRAMTYPE</td>
<td>Ignores the PROGRAM TYPE option for stored procedures in a comparison</td>
</tr>
<tr>
<td>Keyword</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>NOSPQUALIFIER</td>
<td>Ignores the qualifier option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPREGISTERS</td>
<td>Ignores the SPECIAL REGISTER option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPRELEASEAT</td>
<td>Ignores the release option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPREADOPT</td>
<td>Ignores the REOPT option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPRESSET</td>
<td>Ignores the result sets option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPROUNDING</td>
<td>Ignores the Rounding option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPROMPTS</td>
<td>Ignores the RUNOPTS option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPSECURITY</td>
<td>Ignores the EXTERNAL SECURITY option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPSQLPATH</td>
<td>Ignores the SQL path (PATHSCHEMAS) option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPSTAYRESIDENT</td>
<td>Ignores the STAY RESIDENT option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPTEXT</td>
<td>Ignores the text option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPFORMAT</td>
<td>Ignores the time format option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPVALIDATE</td>
<td>Ignores the VALIDATE option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPWLMEENV</td>
<td>Ignores the WLM environment option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSPWLMNEST</td>
<td>Ignores the WLM environment for nested calls option for stored procedures in a comparison</td>
</tr>
<tr>
<td>NOSTOREDPROCS</td>
<td>Ignores stored procedures in the scope of a comparison</td>
</tr>
<tr>
<td>NOSUBTYPE</td>
<td>Ignores the subtype of a column of a table in a comparison</td>
</tr>
<tr>
<td>NOTBAUDIT</td>
<td>Ignores the AUDIT attribute of a table in a comparison</td>
</tr>
<tr>
<td>NOTBCOLORER</td>
<td>Ignores differences in the order of the columns in a table during a comparison</td>
</tr>
<tr>
<td>NOTBCOLORORDER</td>
<td>If you specify NOTBCOLORORDER and you add a new column to the table, the product adds the column to the end of the table.</td>
</tr>
<tr>
<td>NOTBDEFVALUE</td>
<td>Ignores the default value of a column in a table in a comparison</td>
</tr>
<tr>
<td>NOTBTSAUTO</td>
<td>Does not apply automatic change rules to match all of the table's table space names when comparing at the table level</td>
</tr>
<tr>
<td>NOTSCLOSE</td>
<td>Ignores the CLOSE attribute of a table space in a comparison</td>
</tr>
<tr>
<td>NOVWQUAL</td>
<td>Ignores the QUALIFIED attribute (explicit qualifier) of a view in a comparison</td>
</tr>
<tr>
<td>Keyword</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SPOWNER</td>
<td>Shows the differences between the owners of stored procedures By default, the product does not compare the owners.</td>
</tr>
</tbody>
</table>
| SPTEXT-TRACE| Provides a hexadecimal dump of the text for a stored procedure when all of the following conditions are met:  
|             | ▪ The product retrieves the information from the SYSIBM catalog.                                                                            |
|             | ▪ Compare detects a difference between the text for the primary input and secondary input.                                                    |
| UCNN        | Shows the differences between two unique constraints when one has a three-part explicit name and the other has no name (and part three is not specified) |
Managing Backup and Recovery

The Recovery Management perspective lets you view the status of the recovery process, verify the recoverability of individual objects to a specified recovery point, and estimate the elapsed time for a backup or a recovery.

*Note*

This feature is available if you have a license for the BMC Recovery for DB2 solution.

For more information, view the Quick Course "Workbench for DB2 - Assessing Backup and Recovery Reports."

Viewing recovery progress

Use the following procedure to view the progress of a recovery, and identify which objects in the selected object set were recovered, rebuilt, or not recovered.

**To view a Recovery Progress report**

1. In the Recovery Management perspective, click Add View and select Progress Report from the menu.

2. Complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the report</td>
</tr>
</tbody>
</table>
| RTO Target     | Accept the default value or enter the maximum acceptable Recovery Time Objective *(hh:mm)* for this report.  
To define the default value, see “Setting Recovery Management options” on page 143.  |
| DB2 Connection | Select a DB2 connection from your list of favorites. If necessary, you can add a connection. See “Connecting to DB2 subsystems” on page 25. |
| Object Set     | Navigate to and select an object set.                                      |
Field | Description
---|---
Start Time | Enter a time to begin the Recovery process.
Include Indexes | Select to include index information.

3 Click Run .

The Recovery Progress Report tab is displayed.

In this interactive report, you can refresh and update the results whenever you want. You can click each bar of the bar chart to see a list of the recovered, rebuilt, and not recovered objects in the Details tab.

Figure 6: Recovery Progress Report

![Recovery Progress Report](image)

Table 17: Legend

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Run button</td>
<td>Executes the report</td>
</tr>
<tr>
<td>2</td>
<td>Progress By selector</td>
<td>Lets you choose to display progress by size or by count</td>
</tr>
</tbody>
</table>
| 3 | Size unit selector | *(Progress by Size only)* Lets you choose to display the size in MB, GB, or TB By default, the size is displayed in MB.
<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Progress bar for a table-space partition recovery</td>
<td>Shows how much of the recovery has been completed. You can click the progress bar to view the list of recovered and not recovered table spaces.</td>
</tr>
<tr>
<td>5</td>
<td>Progress bar for an index partition recovery</td>
<td>Shows how much of the recovery has been completed. You can click the progress bar to view the list of recovered, rebuilt, and not recovered index partitions.</td>
</tr>
<tr>
<td>6</td>
<td>Progress bar for all the objects being recovered</td>
<td>Lets you view the list of recovered and not recovered objects.</td>
</tr>
<tr>
<td>7</td>
<td><strong>Time to Completion</strong> field</td>
<td>Shows the estimated time when the recovery will finish</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- ![green_tick] indicates that the recovery will finish within your defined Recovery Time Objective (RTO).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- ![red_alert] indicates that the time will exceed your RTO.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For more information, see Step 2 on page 22.</td>
</tr>
<tr>
<td>8</td>
<td>Recovery Manager options</td>
<td>Displays the Recovery Manager options</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Setting Recovery Management options” on page 143.</td>
</tr>
<tr>
<td>9</td>
<td><strong>Refresh</strong> button</td>
<td>Refreshes the report</td>
</tr>
<tr>
<td>10</td>
<td>Color legend</td>
<td>Indicates the colors that the bar charts use to convey recovery-completion status</td>
</tr>
</tbody>
</table>

**Related Information**

- “Setting Recovery Management options” on page 143
- “Verifying recoverability” on page 133
- “Estimating backup time” on page 137
- “Estimating recovery time” on page 140

**Verifying recoverability**

You can run the Recoverability report to validate the recoverability of each object in an object set to a selected recovery point. The report identifies any objects that are not recoverable. For example, the report identifies specific data sets that do not have available copies. You should run the Recoverability report as part of your routine disaster recovery preparations.
The recoverability information is obtained from the most recent execution of the ARMBGPV program for the selected recovery point. Clicking 🔄 refreshes the recoverability information. For more information, see “Refreshing the recoverability information” on page 136.

**To run the Recoverability report**

1. In the Recovery Management perspective, click Add View 🔄 and select Recoverability Report.

2. In the Definition tab, complete the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the report.</td>
</tr>
<tr>
<td>DB2 Connection</td>
<td>Select a DB2 connection from your list of favorites. If necessary, you can add a connection. See “Connecting to DB2 subsystems” on page 25.</td>
</tr>
<tr>
<td>Object Set</td>
<td>Navigate to and select an object set.</td>
</tr>
<tr>
<td>Recovery Point</td>
<td>Select any of the following recovery points for the object set:</td>
</tr>
<tr>
<td></td>
<td>- To Current: recover to the current time stamp</td>
</tr>
<tr>
<td></td>
<td>- To Copy: recover to the last incremental copy</td>
</tr>
<tr>
<td></td>
<td>- To Full copy: recover to the last full copy</td>
</tr>
<tr>
<td></td>
<td>- To Quiesce: recover to the last quiesce point</td>
</tr>
<tr>
<td></td>
<td>- To Log Mark: recover to a log mark that you defined in the Log Master for DB2 product.</td>
</tr>
<tr>
<td></td>
<td>If you select this option, you must also enter the log mark name.</td>
</tr>
</tbody>
</table>

3. Click Run 🔄.
The Recoverability report tab displays the count of unrecoverable objects and why they cannot be recovered. Clicking **View Details** lists unrecoverable objects in the Details tab.

**Figure 7: Recoverability report**

![Recoverability report diagram](image)

**Table 18: Legend**

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Run button</td>
<td>Executes the report</td>
</tr>
<tr>
<td>2 &amp; 3</td>
<td>Recovery exceptions (two examples shown)</td>
<td>Provides the count of excepted objects and describes the recovery exceptions</td>
</tr>
<tr>
<td>4</td>
<td>View Details button</td>
<td>Lists objects for the recovery exception in the Details tab</td>
</tr>
<tr>
<td>5</td>
<td>Recovery Manager options</td>
<td>Displays the Recovery Manager options</td>
</tr>
</tbody>
</table>

See “Setting Recovery Management options” on page 143.

**Related Information**

- “Setting Recovery Management options” on page 143
- “Viewing recovery progress” on page 131
- “Estimating backup time” on page 137
- “Estimating recovery time” on page 140
Refreshing the recoverability information

You should refresh the recoverability information to ensure that the Recoverability report reflects the most recent execution of the ARMBGPV program for the selected recovery point. The Refresh Recoverability option lets you navigate to and submit one or more ARMBGPV jobs to refresh the recoverability data.

Note
For more information about the ARMBGPV program, see the RECOVERY MANAGER for DB2 User Guide.

To refresh the recoverability information

1. In the Recovery Management perspective, open a Recoverability report.
2. Click Refresh.
3. In the Refresh Recoverability Data panel, navigate to and select a data set containing an ARMBGPV job for an object set.
4. (optional) Enter a description of the ARMBGPV job.
5. (optional) Click Add a data set, and repeat Step 3 on page 136. Continue until you have added all of the recovery JCL to be run.
6. (optional) Click Show JCL to view the ARMBGPV job JCL in the Scratchpad.
7. (optional) In the Scratchpad, edit and save the JCL.
8. Click Submit to run the ARMBGPV job.

If you run the Recoverability report, it will reflect the updated recoverability data.

Estimating backup or recovery time

You can create What-If reports to estimate the required time to backup or recover an object set. By using recovery and backup estimation, you can deal with problem objects and fine-tune your recovery strategy prior to running a backup or recovery scenario.
Estimating backup time

BMC Workbench lets you run a Backup Time Estimation report for an object set. This report shows which backup strategies are estimated to fall within the Backup Time Objective (BTO) that you defined. You can create What-If backup time estimations by hypothetically increasing the size or number of objects in the data set and running the report.

To view a Backup Time Estimation report

1. In the Recovery Management perspective, click Add View and select Time Estimation report from the list.

   The Generate Time Estimation wizard opens.

2. On the wizard’s Step 1 - General page, complete the following fields and click Next:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the report.</td>
</tr>
<tr>
<td>Estimate Backup Time</td>
<td>Select Estimate Backup Time.</td>
</tr>
<tr>
<td>BTO Target</td>
<td>Accept the default value or enter the maximum acceptable Backup Time Objective (hh:mm) for this report. To define the default value, see “Setting Recovery Management options” on page 143.</td>
</tr>
<tr>
<td>DB2 Connection</td>
<td>Select a DB2 connection from your list of favorites. If necessary, you can add a connection. See “Connecting to DB2 subsystems” on page 25.</td>
</tr>
<tr>
<td>Object Set</td>
<td>Navigate to and select an object set.</td>
</tr>
</tbody>
</table>

3. On the wizard’s Step 2 - Backup page, accept the default values or enter new values and click Next:
### Field | Description
--- | ---
**Outsize** | Specify the size threshold for making copies to an alternate DD or output descriptor. Valid values are:
- 0 through 4294967295 KB
- 0 through 4194303 MB
- 0 through 4095 GB
**Note:** If you enter an Outsize value greater than 0, the hybrid elapsed time is the combined time of two estimates.

**Index Size Threshold** | Specify the threshold size at which indexes are backed up rather than rebuilt. (valid values are KB 0 - 4294967295, MB 0 - 4194303, GB 0 - 4095)
- 0 through 4294967295 KB
- 0 through 4194303 MB
- 0 through 4095 GB

**MAXTASKS** | Define the default number of multitasking subtasks that can be performed in parallel when you are making copies. Valid values are 1 through 32.

**Include Indexes** | Select to include indexes in the backup estimation, if they are not already in the object set.

**IO Factor** | Specify the I/O factor. The valid values are 1 through 10000, and the default is 100. A factor of 0 will calculate a new factor estimate.

4 **On the wizard’s Step 3 - Growth page, accept the default values or enter new values:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number of data sets increased by</strong></td>
<td>Enter a percentage or number increase to generate a What-If backup estimation based on an increase in the number of data sets. Valid values are 0 through 32767.</td>
</tr>
<tr>
<td><strong>Size of data sets increased by</strong></td>
<td>Enter a percentage or number increase to generate a What-If backup estimation based on an increase in the size of the data sets. Valid values are 0 through 32767.</td>
</tr>
</tbody>
</table>

5 **Click Finish.**
The General, Backup, and Growth tabs are populated and the Time Estimation Report tab is displayed.

Figure 8: Time Estimation Report

Table 19: Legend

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Run button</td>
<td>Executes the report.</td>
</tr>
<tr>
<td>2</td>
<td>Tabs</td>
<td>■ General (see Step 2 on page 137)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Backup (see Step 3 on page 137)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Growth (see Step 4 on page 138)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Time Estimation Report Tab (see Step 5 on page 132)</td>
</tr>
<tr>
<td>3</td>
<td>Details about the actual objects</td>
<td>Indicates the actual number of objects in your selected group, their actual size, and the applicable I/O factor</td>
</tr>
<tr>
<td>4</td>
<td>Details about the projected objects</td>
<td>Projects what the number and size of objects would be, based on the What-If percentage or number changes that you entered in the Growth tab (see Step 4 on page 138)</td>
</tr>
<tr>
<td>5</td>
<td>Recovery Manager options</td>
<td>Displays the Recovery Manager options</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Setting Recovery Management options” on page 143.</td>
</tr>
<tr>
<td>#</td>
<td>Description</td>
<td>Details</td>
</tr>
<tr>
<td>----</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 6  | Elapsed time      | Estimates the elapsed time needed for each displayed backup strategy  
**Note:** If you enter an Outsize value greater than 0, the hybrid elapsed time is the combined time of two estimates. |
| 7  | Backup strategy   | Estimates values for multiple backup strategies                                                                                       |
| 8  | BTO indicator     | Indicates whether the backup time estimation falls within your Backup Time Objective (BTO):  
✔️ indicates that the time is within your defined BTO  
⚠️ indicates that the time exceeds your BTO |

---

**Related Information**

- “Setting Recovery Management options” on page 143
- “Verifying recoverability” on page 133
- “Viewing recovery progress” on page 131

---

**Estimating recovery time**

BMC Workbench lets you run a Recovery Time Estimation report for an object set. The report shows whether either recovery strategy is applicable and shows recovery time estimations for both (if applicable) backout and forward recovery strategies. The report also shows whether the recovery time estimations fall within the Recovery Time Objective (RTO) that you defined.

**To view a Recovery Time Estimation report**

1. In the Recovery Management perspective, click **Add View**.  
The Generate Time Estimation wizard opens.

2. On the wizard’s **Step1 - General** page, complete the following fields, and click **Next**.
### Field | Description
---|---
Name | Enter a name for the report.
Estimate Recovery Time | Select **Estimate Recovery Time**
RTO Target | Accept the default value or enter the maximum acceptable Recovery Time Objective \((hh:mm)\) for this report. To define the default value, see “Setting Recovery Management options” on page 143.
DB2 Connection | Select a DB2 connection from your list of favorites. If necessary, you can add a connection. See “Connecting to DB2 subsystems” on page 25.
Object Set | Navigate to and select an object set.

3 On the wizard’s **Step 2 - Recovery** page, accept the default values or enter new values and click **Next**:

### Field | Description
---|---
Recovery point | Accept the current date and time, or enter values.
Number of Jobs | Specify the number of jobs in the recovery run. Valid values are 1 (the default) through 99.
MAXLSORT | Specify the maximum number of log sorts that can run concurrently. Valid values are 1 (the default) through 32.
Rebuild Indexes | Select to rebuild indexes in the recovery estimation.
Include Indexes | Select to include indexes in the backup estimation if they are not already in the object set.
IO Factor | Specify the I/O factor. The valid values are 1 through 10000, and the default is 100. A factor of 0 will calculate a new factor estimate.

4 On the wizard’s **Step 3 - Growth** page, accept the default values or enter new values:

### Field | Description
---|---
Number of data sets increased by | Enter a percentage or number increase to generate a What-If recovery estimation based on an increase in the number of data sets. Valid values are 0 through 32767.
Size of data sets increased by | Enter a percentage or number increase to generate a What-If recovery estimation based on an increase in the size of the data sets. Valid values are 0 through 32767.

5 Click **Finish**.
The General, Recovery, and Growth tabs are populated with your input, and the Time Estimation report tab is displayed.

**Figure 9: Recovery Time Estimation report**

**Table 20: Legend**

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Run button</td>
<td>Executes the report.</td>
</tr>
<tr>
<td>2</td>
<td>Tabs</td>
<td>Categorizes the information as follows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ General (see Step 2 on page 137)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Recovery (see Step 3 on page 137)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Growth (see Step 4 on page 138)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Time Estimation Report (see Step 5 on page 132)</td>
</tr>
<tr>
<td>3</td>
<td>Actual data</td>
<td>Indicates the <em>actual</em> number of objects in your selected group, their actual size, and the applicable I/O factor</td>
</tr>
<tr>
<td>4</td>
<td>Projected data</td>
<td>Projects what the number and size of objects would be, based on the What-If percentage or number changes that you entered in the Growth tab (see Step 4 on page 138)</td>
</tr>
</tbody>
</table>
### Setting Recovery Management options

You can optionally define global backup and recovery target times. BMC Workbench can use these values to calculate whether performance times will exceed these values.

BMC Workbench uses these values as default values for any new report.

#### Table 21: Recovery Management options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup Time Objectives (BTO) Target</td>
<td>Enter a value (<strong>hh:mm</strong>).</td>
</tr>
<tr>
<td>Recovery Time Objectives (RTO) Target</td>
<td>Enter a value (<strong>hh:mm</strong>).</td>
</tr>
</tbody>
</table>
Managing JES jobs

You can browse Job Entry Subsystem (JES) jobs running on the LPAR where the UIM server is active.

Viewing JES jobs

Use the following procedure to view JES jobs, job data sets, and job output.

To view JES jobs, job data sets, and job output

1. In the Job Browser perspective, click Add Job Filter.

   **Tip**

   You can remove job filters, by clicking Remove a Job Filter.

2. In the Add Job Filter dialog box, enter a job name.
   
   The wildcard * is supported.

3. Click OK.

   The application searches for jobs that satisfy the filter value. Matching jobs are listed in the results pane.

4. To view the job output, perform one of the following tasks:
   
   - Double-click the required job.
   - Select the required job and click .

   Two panes are displayed in the output view:
The upper pane displays the list of data sets.

The lower pane displays the contents of the data set selected in the upper pane. By default, the job output of the first data set is selected and displayed.

5 (optional) Search for specific values and text strings in the job output.

Guidelines are as follows:

- All standard RegEx values are supported.
- You can use the scroll bars to navigate between the job data sets.
- You can click ⚙ to reload an active job from the server; the jobs list and job output will be updated accordingly. This button is dimmed when you are viewing details of an inactive job.

6 When finished, click Back to Job List 🔄 to return to the job list.

--- Related Information ---

- “Editing text files in Scratchpad” on page 64
- “Running a command from Scratchpad” on page 67
Managing data sets

You can navigate to and edit data set members.

The File Locator perspective provides a visual hierarchical display of the data sets and members, similar to that commonly found on personal computers.

Viewing and editing a data set

Use the following procedure to browse to, select, and edit any file on the IBM z/OS system that you are authorized to access.

1. In the File Locator perspective, click **Add Data Set Filter**.

2. Enter a data set name.
   - The wildcard * is supported.

3. Click **OK** to search for all data sets and data set members (files) that satisfy your filter.
   - The matching data sets and data set members are displayed in a hierarchical tree on the navigator pane. Details of the data sets and data set members are displayed in the results pane.

4. In the hierarchical tree, navigate to the data set that contains the files that you require.

5. If you want to open and view the data set, perform one of the following actions in the results pane:
   - Double-click the file.
   - Select the file and click **Open**.
Tip
You can also right-click in the results pane and select  

6  If you want to edit the file, perform one of the following actions in the results pane:

■ Double-click the file.

■ Select the file and click Edit  

Tip
You can also right-click in the results pane and select  

7 In Scratchpad, view or edit the file, and save any changes.

8 If your data set is archived, respond to the displayed Restore Archive Data dialog box in either of the following ways:

■ Click Yes to restore the data set.

■ Click No to bypass restoring.

Related Information
■ “Editing text files in Scratchpad” on page 64
■ “Setting Scratchpad options” on page 69
Index

.csv 58

A
access to Workbench functions 23
ACTWBREP 30
ad hoc 86
advanced search 47
ALTER 63
Alter command 61

B
Backup Time Objectives 143
Bind command 61
BMC Workbench options 31
BMC Workbench repository 27
browse 55
browsers
   supported 19
BTO 143

C
case sensitive search 64
CATALOG MANAGER 21
CATALOG MANAGER Options 59
catalog objects tab 95
CCSID option 124
CDL 113, 118
Change Definition Language 113
change the filter options 31
changes to the product 10
CISIZE option 124
CKSEGSIZE parameter, OVERRIDE ALuin
   keyword 126
command
   ad-hoc 62
   edit 67
   run 67
   statement cache 62
compare
   tab 95
comparing statements 82
comparison 82
connection manager
   refresh button 27
Continue on error 107
conventions, documentation 10
copy 58
   view 54
copy a layout 32
copy a Schema Compare View 113
copy file 64
copy workspace 37
cost 94
create a Schema Compare View 113
Creating a DB2 statement cache view 52
csv format 57

D
data set
   search 147
DB2 connection
   add 25
   delete 25
   favorite 25
   menu 25
   remove 25
   unsupported version 25
DB2 navigation pane 51
DB2 object view
   create 47
DB2 privileges 19
DB2 statement
grayed out 72
selecting 84
unavailable 72

DBC 19
DCL command 61
DDL command 61
DDL limitations 113
debug messages 29
definition
  perspective 16
  view 16
  workspace 16
degree 98
  set value for 86
delete
  view 53
Delete command 61
delete index. See drop index
Delete previous instances before migration 107
Display command 61
documentation information 9
Drop command 61
drop index 79
drop recovery 69
  unavailable 69

E
edit
  ad-hoc DDL view 64
  command output 64
edit commands
  case sensitive search 64
  copy file 64
  find 64
  redo 64
  RegEx 64
  replace 64
  save 64
  save all 64
  search 64
  undo 64
  electronic documentation 9
element
  search 147
ENQFAILRC4) parameter, OVERRIDE ALUIN keyword 126
Explain diagram
  SQL tab 92
  Explain tree
  SQL tab 92
  status information 92
  export 57

F
filter options 31
find 64
FKNN parameter, OVERRIDE ALUIN keyword 126
folder
  add 41, 42
  create 41
  delete 41
Free command 61

G
Generated statements 82
GENOBID parameter, OVERRIDE ALUIN keyword 126

H
HDDL command 61
  dimmed 61
  HDDL command
    unavailable 61
Help
  online 9

I
INCLUDEPARENTS parameter, OVERRIDE ALUIN keyword 126
index
  adding 77
  copy 80
  drop 79
  edit 81
index name 75
index on expression 77
index statistics 75
Insert command 61
IO Factor 140
IXPADDEDN parameter, OVERRIDE ALUIN keyword 126
IXPADDEDDY parameter, OVERRIDE ALUIN keyword 126

J
job data sets 145
job output 145

K
KEEP-ALL-PRIMARY parameter, OVERRIDE ALUIN keyword 126
key columns 75

L
layout 28
layout options 31
Length of inline LOB columns option 124
LONGVARCOLS parameter, OVERRIDE ALUIN keyword 126

M
MAXLSORT 140
message rules 94
messages
debug 29
error 29
information 29
warning 29
migrating statistics 101
migration stats 101, 104

N
NO-PRIMARY-CONSTRAINTS parameter, OVERRIDE ALUIN keyword 126
NOAPPEND parameter, OVERRIDE ALUIN keyword 126
NOCLONES parameter, OVERRIDE ALUIN keyword 126
NODSSIZE parameter, OVERRIDE ALUIN keyword 126
NOENFORCED parameter, OVERRIDE ALUIN keyword 126
NOGBCACHE parameter, OVERRIDE ALUIN keyword 127
NOINLINELOB parameter, OVERRIDE ALUIN keyword 127
NOIXCLOSE parameter OVERRIDE ALUIN keyword 127
NOIXCOMPRESS parameter, OVERRIDE ALUIN keyword 127
NOIXCOPY parameter, OVERRIDE ALUIN keyword 127
NOIXPADDED parameter, OVERRIDE ALUIN keyword 127
NOLIMITKEYS parameter, OVERRIDE ALUIN keyword 127
NOLOG parameter, OVERRIDE ALUIN keyword 127
NOPLECSIZE parameter, OVERRIDE ALUIN keyword 127
NOAPPEND parameter, OVERRIDE ALUIN keyword 127
NOSPACTIVE parameter, OVERRIDE ALUIN keyword 127
NOSPASUTIME parameter, OVERRIDE ALUIN keyword 127
NOSPCCSID parameter, OVERRIDE ALUIN keyword 127
NOSCURRENTDATA parameter, OVERRIDE ALUIN keyword 127
NOSPDEBUGMODE parameter, OVERRIDE ALUIN keyword 127
NOSPDECIMAL parameter, OVERRIDE ALUIN keyword 127
NOSPDEFERPREPARE parameter, OVERRIDE ALUIN keyword 127
NOSPDEGREE parameter, OVERRIDE ALUIN keyword 127
NOSPDETERMINISTIC parameter, OVERRIDE ALUIN keyword 127
NOSPDEBUGMODE parameter, OVERRIDE ALUIN keyword 127
NOSPDECIMAL parameter, OVERRIDE ALUIN keyword 127
NOSPDEFERPREPARE parameter, OVERRIDE ALUIN keyword 127
NOSPDEGREE parameter, OVERRIDE ALUIN keyword 127
NOSPDETERMINISTIC parameter, OVERRIDE ALUIN keyword 127
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Keyword</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOSPDYNRULES parameter</td>
<td>OVERRIDE ALUIN</td>
<td>127</td>
</tr>
<tr>
<td>NOSPEXPLAIN parameter</td>
<td>OVERRIDE ALUIN</td>
<td>127</td>
</tr>
<tr>
<td>NOSPEXTNAME parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPFORUPD parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPIMMEDWRITE parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPISOLEVEL parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPJAVA parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPKEEPDYN parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPLANGUAGE parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPMAXFAIL parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPPTHINT parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPPACKOWNER parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPPPARAMETERS parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPARKCCSID parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPMDATATYPE parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPARMFORBIT parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPARMINOUT parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPMLOCUS parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPNAME parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPORDER parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPSTYLE parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPVCHAR parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPPROGRAMTYPE parameter</td>
<td>OVERRIDE ALUIN</td>
<td>128</td>
</tr>
<tr>
<td>NOSPQUALIFIER parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOSPREGISTERS parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOSPRESIDENT parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOSPTOPTS parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOSPRESULTSET parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOSPRUNOPTS parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOSPSECURITY parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOSPSQLPATH parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOSPSTAYRESIDENT parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOSPTEXT parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOSPFORMAT parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOSPVALIDATE parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOSPMLMNEST parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOSTOREDPROCS parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOSUBTYPE parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOTBAUDIT parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOTBCOLORDER parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOTBDEFVALUE parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOTBTSAUTO parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOTCLOSE parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
<tr>
<td>NOVWQUAL parameter</td>
<td>OVERRIDE ALUIN</td>
<td>129</td>
</tr>
</tbody>
</table>

0

- object icons 95
- Object Types for HDDL 59
- online application 98
- online Help 9
- options
BMC Workbench 31
DB2 Navigator 59
Scratchpad 69
OS
  supported 19
OVERRIDE 124
OVERRIDE option 124

package
  selecting a statement 85
padded values option 124
paste
  view 54
Performance perspective 87
perspective
  definition 16
plan table owner 98
  set value for 86
predicates 94
primary key constraint 124
product changes 10
publications, related 9

R
Rebind command 61
Recovery Point 133
Recovery Time Objectives 143
redo 64
RegEx 64
related objects
  selecting a table 95
  selecting an object type 95
  tab 95
  toolbar 56
  viewing 95
related publications 9
remove file view 64
remove index. See drop index
reordered row format option 124
replace 64
RTO 143
rule set 98

S
SAF authorization 19
SAF resource 23
save 64
save all workspaces 37
save workspace 37
Schema Compare View
  copy 113
  create 113
schema management
  CCSID option 124
  CISIZE option 124
  European format option 124
  Length of inline LOB columns option 124
  padded values option 124
  primary key constraint option 124
  reordered row format option 124
  white spaces in native SQL stored procedure
  option 124
scratchpad 64
search 64
  advanced 47
Select command 61
select options 69, 98
select statement 84
server information 29
service unit
  cost per 98
  set the default layout 32
SPOWNER parameter, OVERRIDE ALUIN
  keyword 130
SPTEXT-TRACE parameter, OVERRIDE ALUIN
  keyword 130
SQL statement
  edit 90
  validation 90
Start command 61
statement selection 84
statistic migration options 107
  Continue on error 107
  Delete previous instances before migration 107
statistics migration 101
stats migration 101, 104
status
  severe 92
  warning 92
status of workspace 33
T

tab
  indexes 91
  table qualifier 98
  set value for 86

template 42
  create 42
  delete 43
  displaying 40
  managing 40
  remove 43

templates
  move 44

timeron
  cost per 98

Timestamp to use for STATTIME 107

total cost 92

TSO 21

U

UCNN parameter, OVERRIDE ALUIN keyword 130

UCPKPALL installation option 126

UIM 19

UIM properties 29

undo 64

Update command 61

User Interface Middleware properties 29

V

view
  copy 54
  definition 16
  delete 53
  paste 54

viewing
  job data sets 145
  job output 145

W

What-If 73

What-If index
  dimmed 75
  unavailable 75

white spaces in native SQL stored procedure option 124

workflow
  SQL tuning 71

workspace
  close 39
  creating from template 35
  creating new 34
  definition 16
  delete 39
  edit 40
  open 38
  remove 39
  saving 37

workspace icon 33

Z

zoom
  SQL tab 92